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PORTLAND CEMENT ASSOCIATION  
EVALUATION SOFTWARE LICENSE AGREEMENT 

 
BY CLICKING THE “I AGREE” ICON BELOW, OR BY INSTALLING, COPYING, OR 
OTHERWISE USING THE SOFTWARE OR USER DOCUMENTATION, YOU AGREE TO BE 
BOUND BY THE TERMS OF THIS AGREEMENT, INCLUDING, BUT NOT LIMITED TO, THE 
WARRANTY DISCLAIMERS, LIMITATIONS OF LIABILITY AND TERMINATION 
PROVISIONS BELOW. IF YOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT, DO 
NOT INSTALL OR USE THE SOFTWARE OR USER DOCUMENTATION, EXIT THIS 
APPLICATION NOW AND RETURN THE SOFTWARE AND USER DOCUMENTATION TO 
PCA.  
PORTLAND CEMENT ASSOCIATION, 5420 OLD ORCHARD ROAD, SKOKIE, ILLINOIS 60077 
(HEREAFTER PCA), GRANTS THE CUSTOMER A PERSONAL, NONEXCLUSIVE, LIMITED, 
NONTRANSFERABLE LICENSE TO USE THIS SOFTWARE AND USER DOCUMENTATION 
SOLELY FOR TRIAL AND EVALUATION PURPOSES ONLY IN ACCORDANCE WITH THE 
TERMS AND CONDITIONS OF THIS AGREEMENT. SOFTWARE AND USER 
DOCUMENTATION IS SUPPLIED TO CUSTOMER EITHER BY PCA DIRECTLY OR 
THROUGH AN AUTHORIZED DEALER OF PCA (HEREAFTER DEALER). 
WHILE PCA HAS TAKEN PRECAUTIONS TO ASSURE THE CORRECTNESS OF THE 
ANALYTICAL SOLUTION AND DESIGN TECHNIQUES USED IN THIS SOFTWARE, IT 
CANNOT AND DOES NOT GUARANTEE ITS PERFORMANCE, NOR CAN IT OR DOES IT 
BEAR ANY RESPONSIBILITY FOR DEFECTS OR FAILURES IN STRUCTURES IN 
CONNECTION WITH WHICH THIS SOFTWARE MAY BE USED. DEALER (IF ANY) HAS NOT 
PARTICIPATED IN THE DESIGN OR DEVELOPMENT OF THIS SOFTWARE AND NEITHER 
GUARANTEES THE PERFORMANCE OF THE SOFTWARE NOR BEARS ANY 
RESPONSIBILITY FOR DEFECTS OR FAILURES IN STRUCTURES IN CONNECTION WITH 
WHICH THIS SOFTWARE IS USED. 
PCA AND DEALER (IF ANY) EXPRESSLY DISCLAIM ANY WARRANTY THAT: (A) THE 
FUNCTIONS CONTAINED IN THE SOFTWARE WILL MEET THE REQUIREMENTS OF 
CUSTOMER OR OPERATE IN COMBINATIONS THAT MAY BE SELECTED FOR USE BY 
CUSTOMER; (B) THE OPERATION OF THE SOFTWARE WILL BE FREE OF ALL "BUGS" OR 
PROGRAM ERRORS; OR (C) THE SOFTWARE CONFORMS TO ANY PERFORMANCE 
SPECIFICATIONS. CUSTOMER ACKNOWLEDGES THAT PCA IS UNDER NO OBLIGATION 
TO PROVIDE ANY SUPPORT, UPDATES, BUG FIXES OR ERROR CORRECTIONS TO OR FOR 
THE SOFTWARE OR USER DOCUMENTATION.  
THE LIMITED WARRANTIES IN SECTION 6 HEREOF ARE IN LIEU OF ALL OTHER 
WARRANTIES, EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, ANY 
IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FIT NESS 
FOR A PARTICULAR PURPOSE, EACH OF WHICH IS HEREBY DISCLAIMED. EXCEPT 
AS SET FORTH IN SECTION 6, THE SOFTWARE AND USER DOCUMENTATION ARE 
PROVIDED ON AN "AS-IS" BASIS.  
IN NO EVENT SHALL PCA OR DEALER (IF ANY) BE LIABLE FOR: (A) LOSS OF PROFITS, 
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, PUNITIVE, CONSEQUENTIAL 
OR OTHER DAMAGES, EVEN IF PCA OR DEALER (IF ANY) HAS BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES; (B) ANY CLAIM AGAINST CUSTOMER BY ANY THIRD 

 



 

PARTY; OR (C) ANY DAMAGES CAUSED BY (1) DELAY IN DELIVERY OF THE SOFTWARE 
OR USER DOCUMENTATION UNDER THIS AGREEMENT; (2) THE PERFORMANCE OR NON 
PERFORMANCE OF THE SOFTWARE; (3) RESULTS FROM USE OF THE SOFTWARE OR 
USER DOCUMENTATION, INCLUDING, WITHOUT LIMITATION, MISTAKES, ERRORS, 
INAC CURACIES, FAILURES OR CUSTOMER'S INABILITY TO PROVIDE SERVICES TO 
THIRD PARTIES THROUGH USE OF THE SOFTWARE OR USER DOCUMENTATION; 
(4) CUSTOMER'S FAILURE TO PERFORM CUSTOMER'S RESPONSIBILI TIES; (5) PCA NOT 
PROVIDING UPDATES, BUG FIXES OR CORRECTIONS TO OR FOR ANY OF THE 
SOFTWARE OR USER DOCUMENTATION; (6) LABOR, EXPENSE OR MATERIALS 
NECESSARY TO REPAIR DAMAGE TO THE SOFTWARE OR USER DOCUMENTATION 
CAUSED BY (a) ACCIDENT, (b) NEGLI GENCE OR ABUSE BY CUSTOMER, (c) ACTS OF 
THIRD PERSONS INCLUDING, BUT NOT LIMITED TO, INSTALLATION, REPAIR, 
MAINTENANCE OR OTHER CORRECTIVE WORK RELATED TO ANY EQUIPMENT BEING 
USED, (d) CAUSES EXTERNAL TO THE SOFTWARE SUCH AS POWER FLUCTUATION AND 
FAILURES, OR (e) FLOODS, WINDSTORMS OR OTHER ACTS OF GOD. MOREOVER, IN NO 
EVENT SHALL PCA BE LIABLE FOR WARRANTIES, GUARANTEES, REPRESENTATIONS 
OR ANY OTHER UNDERSTAN DINGS BETWEEN CUSTOMER AND DEALER (IF ANY) 
RELATING TO THE SOFTWARE OR USER DOCUMENTATION. 
THIS AGREEMENT CONSTITUTES THE ENTIRE AND EXCLUSIVE AGREEMENT BETWEEN 
CUSTOMER AND PCA AND DEALER (IF ANY) WITH RESPECT TO THE SOFTWARE AND 
USER DOCUMENTATION TO BE FURNISHED HEREUNDER. IT IS A FINAL EXPRESSION OF 
THAT AGREEMENT AND UNDERSTANDING. IT SUPER SEDES ALL PRIOR 
COMMUNICATIONS BETWEEN THE PARTIES (INCLUDING ANY EVALUATION LICENSE 
AND ALL ORAL AND WRITTEN PROPOSALS). ORAL STATEMENTS MADE BY PCA'S OR 
DEALER'S (IF ANY) REPRESENTATIVES ABOUT THE SOFTWARE OR USER DOCUMEN 
TATION DO NOT CONSTITUTE REPRESENTATIONS OR WARRANTIES, SHALL NOT BE 
RELIED ON BY CUSTOMER, AND ARE NOT PART OF THIS AGREEMENT. 
 
1. LICENSE RESTRICTIONS  

(a) Except as expressly provided in this Agreement or as otherwise authorized in writing by PCA, 
Customer has no right to: (1) use, print, copy, display, reverse assemble, reverse engineer, 
translate or decompile the Software or User Documentation in whole or in part; (2) disclose, 
publish, release, sublicense or transfer to another person any Software or User Documentation; 
(3) reproduce the Software or User Documentation for the use or benefit of anyone other than 
Customer; or (4) modify any Software or User Documentation. All rights to the Software and 
User Documentation not expressly granted to Customer hereunder are retained by PCA. All 
copyrights and other proprietary rights except as expressed elsewhere in the Software or User 
Documentation and legal title thereto shall remain in PCA. Customer may use the Software at 
only one designated workstation at Customer's site at any given time. Customer may not transmit 
the Software electronically to any other workstation, computer, node or terminal device whether 
via a local area network, a wide area network, telecommunications transmission, the Internet or 
other means now known or hereafter created without prior written permission by PCA.  

(b) Customer acknowledges that this is a limited license for trial and evaluation purposes only. This 
limited license shall automatically terminate upon the earlier of: (1) ten executions of the 
Software on the computer on which it is installed; or (2) fifteen days after the installation of the 
Software. Thereafter, Customer may only use the Software and Documentation if it acquires a 
production license for the same.  
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2. TERM AND TERMINATION  

(a) This Agreement shall be in effect from the date Customer clicks the “I AGREE” icon below or 
installs, copies or otherwise uses the Software or User Documentation until: (1) it is terminated by 
Customer, by Dealer (if any) on behalf of Customer or PCA or by PCA as set forth herein; or 
(2) the limited trial and evaluation license terminates.  

(b) This Agreement may be terminated by PCA without cause upon 30 days' written notice or 
immediately upon notice to Customer if Customer breaches this Agreement or fails to comply 
with any of its terms or conditions. This Agreement may be terminated by Customer without 
cause at any time upon written notice to PCA.  

 
3. BACKUP AND REPLACEMENT COPIES  

Customer may make one copy of the Software for back-up and archival purposes only, provided 
PCA's copyright and other proprietary rights notices are included on such copy.  

 
4. PROTECTION AND SECURITY  

(a) Customer shall not provide or otherwise make available any of the Software or User 
Documentation in any form to any person other than employees of Customer with the need to 
know, without PCA's written permission. 

(b) All Software and User Documentation in Customer's possession including, without limitation, 
translations, compilations, back-up, and partial copies is the property of PCA. Upon termination 
of this Agreement for any reason, Customer shall immediately destroy all Software and User 
Documentation, including all media, and destroy any Software that has been copied onto other 
magnetic storage devices. Upon PCA’s request, Customer shall certify its compliance in writing 
with the foregoing to PCA. 

(c) Customer shall take appropriate action, by instruction, agreement or otherwise, with any persons 
permitted access to the Software or User Documentation, to enable Customer to satisfy its 
obligations under this Agreement with respect to use, copying, protection, and security of the 
same. 

(d) If PCA prevails in an action against Customer for breach of the provisions of this Section 4, 
Customer shall pay the reasonable attorneys' fees, costs, and expenses incurred by PCA in 
connection with such action in addition to any award of damages. 

 
5. CUSTOMER'S RESPONSIBILITIES  

The essential purpose of this Agreement is to provide Customer with limited use rights to the 
Software and User Documentation. Customer accepts full responsibility for: (a) selection of the 
Software and User Documentation to satisfy Customer's business needs and achieve Customer's 
intended results; (b) the use, set-up and installation of the Software and User Documentation; 
(c) all results obtained from use of the Software and User Documentation; and (d) the selection, 
use of, and results obtained from any other software, programming equipment or services used 
with the Software or User Documentation. 

 
6. LIMITED WARRANTIES  

PCA and Dealer (if any) warrants to Customer that: (a) PCA and Dealer (if any) has title to the 
Software and User Documentation and/or the right to grant Customer the rights granted 
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hereunder; (b) the Software and User Documentation provided hereunder is PCA's most current 
production version thereof; and (c) the copy of the Software provided hereunder is an accurate 
reproduction of the original from which it was made.  

 
7. LIMITATION OF REMEDY  

(a) PCA AND DEALER (IF ANY) HAS NO LIABILITY UNDER THIS AGREEMENT. 
CUSTOMER'S EXCLUSIVE REMEDY FOR DAMAGES DUE TO PERFORMANCE OR 
NONPERFORMANCE OF ANY SOFTWARE OR USER DOCUMENTATION, PCA, 
DEALER (IF ANY), OR ANY OTHER CAUSE WHATSO EVER, AND REGARDLESS 
OF THE FORM OF ACTION, WHETHER IN CONTRACT OR IN TORT, INCLUDING 
NEGLIGENCE, SHALL BE LIMITED TO CUSTOMER STOPPING ALL USE OF THE 
SOFTWARE AND USER DOCUMENTATION AND RETURNING THE SAME TO PCA.  

(b) NEITHER PCA NOR DEALER (IF ANY) IS AN INSURER WITH REGARD TO THE 
PERFORMANCE OF THE SOFTWARE OR USER DOCUMENTATION. THE TERMS 
OF THIS AGREEMENT, INCLUDING, BUT NOT LIMITED TO, THE LIMITED 
WARRANTIES, AND THE LIMITATION OF LIABILITY AND REMEDY, ARE A 
REFLECTION OF THE RISKS ASSUMED BY THE PARTIES. IN ORDER TO OBTAIN 
THE SOFTWARE AND USER DOCUMENTATION FROM PCA OR DEALER (IF ANY), 
CUSTOMER HEREBY ASSUMES THE RISKS FOR (1) ALL LIABILITIES 
DISCLAIMED BY PCA AND DEALER (IF ANY) ON THE FACE HEREOF; AND 
(2) ALL ACTUAL OR ALLEGED DAMAGES IN CONNECTION WITH THE USE OF 
THE SOFTWARE AND USER DOCUMENTATION. THE ESSENTIAL PURPOSE OF 
THE LIMITED REMEDY PROVIDED CUSTOMER HEREUNDER IS TO ALLOCATE 
THE RISKS AS PROVIDED ABOVE. 

 
8. U.S. GOVERNMENT RESTRICTED RIGHTS  

This commercial computer software and commercial computer software documentation were 
developed exclusively at private expense by Portland Cement Association, 5420 Old Orchard 
Road, Skokie, Illinois, 60077. U.S. Government rights to use, modify, release, reproduce, 
perform, display or disclose this computer software and computer software documentation are 
subject to the restrictions of DFARS 227.7202-1(a) (June 1995) and DFARS 227.7202-3(a) (June 
1995), or the Restricted Rights provisions of FAR 52.227-14 (June 1987) and FAR 52.227-19 
(June 1987), as applicable. 

 
9. GENERAL  

(a) No action arising out of any claimed breach of this Agreement or transactions under this 
Agreement may be brought by Customer more than two years after the cause of such action has 
arisen. 

(b) Customer may not assign, sell, sublicense or otherwise transfer this Agreement, the license granted 
herein or the Software or User Documentation by operation of law or otherwise without the prior 
written consent of PCA. Any attempt to do any of the foregoing without PCA’s consent is void.  

(c) Customer acknowledges that the Software, User Documentation and other proprietary information 
and materials of PCA are unique and that, if Customer breaches this Agreement, PCA may not 
have an adequate remedy at law and PCA may enforce its rights hereunder by an action for 
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damages and/or injunctive or other equitable relief without the necessity of proving actual damage 
or posting a bond therefor. 

(D) THE RIGHTS AND OBLIGATIONS UNDER THIS AGREEMENT SHALL NOT BE 
GOVERNED BY THE UNITED NATIONS CONVENTION ON CONTRACTS FOR THE 
INTERNATIONAL SALE OF GOODS, THE APPLICATION OF WHICH IS EXPRESSLY 
EXCLUDED, BUT SUCH RIGHTS AND OBLIGATIONS SHALL INSTEAD BE GOVERNED 
BY THE LAWS OF THE STATE OF ILLINOIS, APPLICABLE TO CONTRACTS ENTERED 
INTO AND PERFORMED ENTIRELY WITHIN THE STATE OF ILLINOIS AND 
APPLICABLE FEDERAL (U.S.) LAWS. UCITA SHALL NOT APPLY TO THIS 
AGREEMENT.  

(E) THIS AGREEMENT SHALL BE TREATED AS THOUGH IT WERE EXECUTED IN THE 
COUNTY OF COOK, STATE OF ILLINOIS, AND WAS TO HAVE BEEN PERFORMED IN 
THE COUNTY OF COOK, STATE OF ILLINOIS. ANY ACTION RE LATING TO THIS 
AGREEMENT SHALL BE INSTITUTED AND PROSECUTED IN A COURT LOCATED IN 
COOK COUNTY, ILLINOIS. CUSTOMER SPECIFICALLY CONSENTS TO 
EXTRATERRITORIAL SERVICE OF PROCESS.  

(f) Except as prohibited elsewhere in this Agreement, this Agreement shall be binding upon and inure 
to the benefit of the personal and legal representatives, permitted successors, and permitted 
assigns of the parties hereto.  

(g) All notices, demands, consents or requests that may be or are required to be given by any party to 
another party shall be in writing. All notices, demands, consents or requests given by the parties 
hereto shall be sent either by U.S. certified mail, postage prepaid or by an overnight international 
delivery service, addressed to the respective parties. Notices, demands, consents or requests 
served as set forth herein shall be deemed sufficiently served or given at the time of receipt 
thereof.  

(h) The various rights, options, elections, powers, and remedies of a party or parties to this Agreement 
shall be construed as cumulative and no one of them exclusive of any others or of any other legal 
or equitable remedy that said party or parties might otherwise have in the event of breach or 
default in the terms hereof. The exercise of one right or remedy by a party or parties shall not in 
any way impair its rights to any other right or remedy until all obligations imposed on a party or 
parties have been fully performed. 

(i) No waiver by Customer, PCA or Dealer (if any) of any breach, provision, or default by the other 
shall be deemed a waiver of any other breach, provision or default.  

(j) The parties hereto, and each of them, agree that the terms of this Agreement shall be given 
a neutral interpretation and any ambiguity or uncertainty herein should not be construed against 
any party hereto. 

(k) If any provision of this Agreement or portion thereof is held to be unenforceable or invalid by any 
court or competent jurisdiction, such decision shall not have the effect of invalidating or voiding 
the remainder of this Agreement, it being the intent and agreement of the parties that this 
Agreement shall be deemed amended by modifying such provision to the extent necessary to 
render it enforceable and valid while preserving its intent or, if such modification is not possible, 
by substituting therefor another provision that is enforceable and valid so as to materially 
effectuate the parties’ intent.  

(l) Except as set forth herein, this Agreement may be modified or amended only by a written 
instrument signed by a duly authorized representative of PCA and Customer. 
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PORTLAND CEMENT ASSOCIATION 
SOFTWARE LICENSE AGREEMENT 

 
BY CLICKING THE “I AGREE” BELOW, OR BY INSTALLING, COPYING, OR OTHERWISE 
USING THE SOFTWARE OR USER DOCUMENTATION, YOU AGREE TO BE BOUND BY THE 
TERMS OF THIS AGREEMENT, INCLUDING, BUT NOT LIMITED TO, THE WARRANTY 
DISCLAIMERS, LIMITATIONS OF LIABILITY AND TERMINATION PROVISIONS BELOW. IF 
YOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT, DO NOT INSTALL OR USE 
THE SOFTWARE OR USER DOCUMENTATION, EXIT THIS APPLICATION NOW AND 
RETURN THE SOFTWARE AND USER DOCUMENTATION TO PCA FOR A FULL REFUND 
WITHIN THIRTY DAYS AFTER YOUR RECEIPT OF THE SOFTWARE AND USER 
DOCUMENTATION. 
PORTLAND CEMENT ASSOCIATION, 5420 OLD ORCHARD ROAD, SKOKIE, ILLINOIS 60077 
(HEREAFTER PCA), GRANTS THE CUSTOMER A PERSONAL, NONEXCLUSIVE, LIMITED, 
NONTRANSFERABLE LICENSE TO USE THIS SOFTWARE AND USER DOCUMENTATION 
IN ACCORDANCE WITH THE TERMS AND CONDITIONS OF THIS AGREEMENT. 
SOFTWARE AND USER DOCUMENTATION IS SUPPLIED TO CUSTOMER EITHER BY PCA 
DIRECTLY OR THROUGH AN AUTHORIZED DEALER OF PCA (HEREAFTER DEALER). 
WHILE PCA HAS TAKEN PRECAUTIONS TO ASSURE THE CORRECTNESS OF THE 
ANALYTICAL SOLUTION AND DESIGN TECHNIQUES USED IN THIS SOFTWARE, IT 
CANNOT AND DOES NOT GUARANTEE ITS PERFORMANCE, NOR CAN IT OR DOES IT 
BEAR ANY RESPONSIBILITY FOR DEFECTS OR FAILURES IN STRUCTURES IN 
CONNECTION WITH WHICH THIS SOFTWARE IS USED. DEALER (IF ANY) HAS NOT 
PARTICIPATED IN THE DESIGN OR DEVELOPMENT OF THIS SOFTWARE AND NEITHER 
GUARANTEES THE PERFORMANCE OF THE SOFTWARE NOR BEARS ANY 
RESPONSIBILITY FOR DEFECTS OR FAILURES IN STRUCTURES IN CONNECTION WITH 
WHICH THIS SOFTWARE IS USED. 
PCA AND DEALER (IF ANY) EXPRESSLY DISCLAIM ANY WARRANTY THAT: (A) THE 
FUNCTIONS CONTAINED IN THE SOFTWARE WILL MEET THE REQUIREMENTS OF 
CUSTOMER OR OPERATE IN COMBINATIONS THAT MAY BE SELECTED FOR USE BY 
CUSTOMER; (B) THE OPERATION OF THE SOFTWARE WILL BE FREE OF ALL "BUGS" OR 
PROGRAM ERRORS; OR (C) THE SOFTWARE CONFORMS TO ANY PERFORMANCE 
SPECIFICATIONS. CUSTOMER ACKNOWLEDGES THAT PCA IS UNDER NO OBLIGATION 
TO PROVIDE ANY SUPPORT, UPDATES, BUG FIXES OR ERROR CORRECTIONS TO OR FOR 
THE SOFTWARE OR USER DOCUMENTATION.  
THE LIMITED WARRANTIES IN SECTION 7 HEREOF ARE IN LIEU OF ALL OTHER 
WARRANTIES, EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, ANY 
IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS 
FOR A PARTICULAR PURPOSE, EACH OF WHICH IS HEREBY DISCLAIMED. EXCEPT 
AS SET FORTH IN SECTION 7, THE SOFTWARE AND USER DOCUMENTATION ARE 
PROVIDED ON AN "AS-IS" BASIS.  
IN NO EVENT SHALL PCA OR DEALER (IF ANY) BE LIABLE FOR: (A) LOSS OF 
PROFITS, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, PUNITIVE, 
CONSEQUENTIAL OR OTHER DAMAGES, EVEN IF PCA OR DEALER (IF ANY) HAS 
BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES; (B) ANY CLAIM AGAINST 
CUSTOMER BY ANY THIRD PARTY EXCEPT AS PROVIDED IN SECTION 8 ENTITLED 
"INFRINGEMENT"; OR (C) ANY DAMAGES CAUSED BY (1) DELAY IN DELIVERY OF 
THE SOFTWARE OR USER DOCUMENTATION UNDER THIS AGREEMENT; (2) THE 
PERFORMANCE OR NONPERFORMANCE OF THE SOFTWARE; (3) RESULTS FROM 
USE OF THE SOFTWARE OR USER DOCUMENTATION, INCLUDING, WITHOUT 
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LIMITATION, MISTAKES, ERRORS, INACCURACIES, FAILURES OR CUSTOMER'S 
INABILITY TO PROVIDE SERVICES TO THIRD PARTIES THROUGH USE OF THE 
SOFTWARE OR USER DOCUMENTATION; (4) CUSTOMER'S FAILURE TO PERFORM 
CUSTOMER'S RESPONSIBILITIES; (5) PCA NOT PROVIDING UPDATES, BUG FIXES OR 
CORRECTIONS TO OR FOR ANY OF THE SOFTWARE OR USER DOCUMENTATION; (6) 
LABOR, EXPENSE OR MATERIALS NECESSARY TO REPAIR DAMAGE TO THE 
SOFTWARE OR USER DOCUMENTATION CAUSED BY (a) ACCIDENT, (b) NEGLIGENCE 
OR ABUSE BY CUSTOMER, (c) ACTS OF THIRD PERSONS INCLUDING, BUT NOT 
LIMITED TO, INSTALLATION, REPAIR, MAINTENANCE OR OTHER CORRECTIVE 
WORK RELATED TO ANY EQUIPMENT BEING USED, (d) CAUSES EXTERNAL TO THE 
SOFTWARE SUCH AS POWER FLUCTUATION AND FAILURES, OR (e) FLOODS, 
WINDSTORMS OR OTHER ACTS OF GOD. MOREOVER, IN NO EVENT SHALL PCA BE 
LIABLE FOR WARRANTIES, GUARANTEES, REPRESENTATIONS OR ANY OTHER 
UNDERSTANDINGS BETWEEN CUSTOMER AND DEALER (IF ANY) RELATING TO THE 
SOFTWARE OR USER DOCUMENTATION. 
THIS AGREEMENT CONSTITUTES THE ENTIRE AND EXCLUSIVE AGREEMENT BETWEEN 
CUSTOMER AND PCA AND DEALER (IF ANY) WITH RESPECT TO THE SOFTWARE AND 
USER DOCUMENTATION TO BE FURNISHED HEREUNDER. IT IS A FINAL EXPRESSION OF 
THAT AGREEMENT AND UNDERSTANDING. IT SUPERSEDES ALL PRIOR 
COMMUNICATIONS BETWEEN THE PARTIES (INCLUDING ANY EVALUATION LICENSE 
AND ALL ORAL AND WRITTEN PROPOSALS). ORAL STATEMENTS MADE BY PCA'S OR 
DEALER'S (IF ANY) REPRESENTATIVES ABOUT THE SOFTWARE OR USER 
DOCUMENTATION DO NOT CONSTITUTE REPRESENTATIONS OR WARRANTIES, SHALL 
NOT BE RELIED ON BY CUSTOMER, AND ARE NOT PART OF THIS AGREEMENT. 
 
1. LICENSE RESTRICTIONS  

(a) Except as expressly provided in this Agreement or as otherwise authorized in writing by PCA, 
Customer has no right to: (1) use, print, copy, display, reverse assemble, reverse engineer, 
translate or decompile the Software or User Documentation in whole or in part; (2) disclose, 
publish, release, sublicense or transfer to another person any Software or User Documentation; (3) 
reproduce the Software or User Documentation for the use or benefit of anyone other than 
Customer; or (4) modify any Software or User Documentation. All rights to the Software and 
User Documentation not expressly granted to Customer hereunder are retained by PCA. All 
copyrights and other proprietary rights except as expressed elsewhere in the Software or User 
Documentation and legal title thereto shall remain in PCA. Customer may use the Software at 
only one designated workstation at Customer's site at any given time. Customer may not transmit 
the Software electronically to any other workstation, computer, node or terminal device whether 
via a local area network, a wide area network, telecommunications transmission, the Internet or 
other means now known or hereafter created without prior written permission by PCA.  

(B) CUSTOMER ACKNOWLEDGES THAT THE REGISTRATION PROCESS FOR THE 
SOFTWARE RESULTS IN THE GENERATION OF A UNIQUE LICENSE KEY AND 
ACTIVATION CODE PAIR. ONCE THE LICENSE KEY AND ACTIVATION CODE 
ARE ENTERED DURING THE INSTALLATION PROCESS, THE SOFTWARE WILL 
ONLY WORK ON THE COMPUTER ON WHICH THE SOFTWARE IS INITIALLY 
INSTALLED. IF YOU NEED TO DEINSTALL THE SOFTWARE AND REINSTALL 
THE SOFTWARE ON A DIFFERENT COMPUTER, YOU MUST CONTACT PCA TO 
OBTAIN THE NECESSARY REINSTALLATION PROCEDURES.  
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2. CHARGES AND PAYMENTS  
All payments for the Software and User Documentation shall be made to either PCA or Dealer (if 
any), as appropriate. 

 
3. TERM AND TERMINATION  

(a) This Agreement shall be in effect from the date Customer clicks the “I AGREE” below or installs, 
copies or otherwise uses the Software or User Documentation until it is terminated by Customer, 
by Dealer (if any) on behalf of Customer or PCA or by PCA as set forth herein.  

(b) This Agreement may be terminated by PCA without cause upon 30 days' written notice or 
immediately upon notice to Customer if Customer breaches this Agreement or fails to comply 
with any of its terms or conditions. This Agreement may be terminated by Customer without 
cause at any time upon written notice to PCA.  

 
4. BACKUP AND REPLACEMENT COPIES  

Customer may make one copy of the Software for back-up and archival purposes only, provided 
PCA's copyright and other proprietary rights notices are included on such copy.  

 
5. PROTECTION AND SECURITY  

(a) Customer shall not provide or otherwise make available any of the Software or User Documentation 
in any form to any person other than employees of Customer with the need to know, without 
PCA's written permission. 

(b) All Software and User Documentation in Customer's possession including, without limitation, 
translations, compilations, back-up, and partial copies is the property of PCA. Upon termination 
of this Agreement for any reason, Customer shall immediately destroy all Software and User 
Documentation, including all media, and destroy any Software that has been copied onto other 
magnetic storage devices. Upon PCA’s request, Customer shall certify its compliance in writing 
with the foregoing to PCA. 

(c) Customer shall take appropriate action, by instruction, agreement or otherwise, with any persons 
permitted access to the Software or User Documentation, to enable Customer to satisfy its 
obligations under this Agreement with respect to use, copying, protection, and security of the 
same. 

(d) If PCA prevails in an action against Customer for breach of the provisions of this Section 5, 
Customer shall pay the reasonable attorneys' fees, costs, and expenses incurred by PCA in 
connection with such action in addition to any award of damages. 

 
6. CUSTOMER'S RESPONSIBILITIES  

The essential purpose of this Agreement is to provide Customer with limited use rights to the 
Software and User Documentation. Customer accepts full responsibility for: (a) selection of the 
Software and User Documentation to satisfy Customer's business needs and achieve Customer's 
intended results; (b) the use, set-up and installation of the Software and User Documentation; (c) 
all results obtained from use of the Software and User Documentation; and (d) the selection, use 
of, and results obtained from any other software, programming equipment or services used with 
the Software or User Documentation. 
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7. LIMITED WARRANTIES  
PCA and Dealer (if any) warrants to Customer that: (a) PCA and Dealer (if any) has title to the 
Software and User Documentation and/or the right to grant Customer the rights granted 
hereunder; (b) the Software and User Documentation provided hereunder is PCA's most current 
production version thereof; and (c) the copy of the Software provided hereunder is an accurate 
reproduction of the original from which it was made.  

 
8. INFRINGEMENT  
(a) PCA shall defend Customer against a claim that the Software or User Documentation furnished and 
used within the scope of the license granted hereunder infringes a U.S. patent or U.S. registered 
copyright of any third party that was issued or registered, as applicable, as of the date Customer clicked 
the “I AGREE” below or installed, copied or otherwise began using the Software or User 
Documentation, and PCA shall pay resulting costs, damages, and attorneys' fees finally awarded, 
subject to the limitation of liability set forth in Section 9 entitled "Limitation of Remedy," provided 
that: 

1. Customer promptly notifies PCA in writing of the claim. 
2. PCA has sole control of the defense and all related settlement negotiations.  
3. If such claim has occurred or in PCA's opinion is likely to occur, Customer shall permit PCA at its 
sole option and expense either to procure for Customer the right to continue using the Software or 
User Documentation or to replace or modify the same so that it becomes noninfringing. If neither of 
the foregoing alternatives is reasonably available in PCA's sole judgment, Customer shall, on one 
month's written notice from PCA, return to PCA the Software and User Documentation and all 
copies thereof.  

(b) PCA shall have no obligation to defend Customer or to pay costs, damages or attorneys' fees for any 
claim based upon (1) use of other than a current unaltered release of the Software or User 
Documentation, or (2) the combination, operation or use of any Software or User Documentation 
furnished hereunder with any other software, documentation or data if such infringement would have 
been avoided but for the combination, operation or use of the Software or User Documentation with 
other software, documentation or data. 
(c) The foregoing states the entire obligation of PCA and Customer’s sole remedy with respect to 
infringement matters relating to the Software and User Documentation. 
 
9. LIMITATION OF REMEDY  

(a) PCA'S AND DEALER'S (IF ANY) ENTIRE LIABILITY AND CUSTOMER'S EXCLUSIVE 
REMEDY FOR DAMAGES DUE TO PERFORMANCE OR NONPERFORMANCE OF 
ANY SOFTWARE OR USER DOCUMENTATION, PCA, DEALER (IF ANY), OR ANY 
OTHER CAUSE WHATSOEVER, AND REGARDLESS OF THE FORM OF ACTION, 
WHETHER IN CONTRACT OR IN TORT, INCLUDING NEGLIGENCE, SHALL BE 
LIMITED TO THE AMOUNT PAID TO PCA OR DEALER (IF ANY) FOR THE 
SOFTWARE AND USER DOCUMENTATION.  

(b) NEITHER PCA NOR DEALER (IF ANY) IS AN INSURER WITH REGARD TO THE 
PERFORMANCE OF THE SOFTWARE OR USER DOCUMENTATION. THE TERMS OF 
THIS AGREEMENT, INCLUDING, BUT NOT LIMITED TO, THE LIMITED 
WARRANTIES, AND THE LIMITATION OF LIABILITY AND REMEDY, ARE A 
REFLECTION OF THE RISKS ASSUMED BY THE PARTIES. IN ORDER TO OBTAIN 
THE SOFTWARE AND USER DOCUMENTATION FROM PCA OR DEALER (IF ANY), 
CUSTOMER HEREBY ASSUMES THE RISKS FOR (1) ALL LIABILITIES DISCLAIMED 
BY PCA AND DEALER (IF ANY) ON THE FACE HEREOF; AND (2) ALL ACTUAL OR 
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ALLEGED DAMAGES IN EXCESS OF THE AMOUNT OF THE LIMITED REMEDY 
PROVIDED HEREUNDER. THE ESSENTIAL PURPOSE OF THE LIMITED REMEDY 
PROVIDED CUSTOMER HEREUNDER IS TO ALLOCATE THE RISKS AS PROVIDED 
ABOVE. 

 
10. U.S. GOVERNMENT RESTRICTED RIGHTS  

This commercial computer software and commercial computer software documentation were 
developed exclusively at private expense by Portland Cement Association, 5420 Old Orchard 
Road, Skokie, Illinois 60077. U.S. Government rights to use, modify, release, reproduce, 
perform, display or disclose this computer software and computer software documentation are 
subject to the restrictions of DFARS 227.7202-1(a) (June 1995) and DFARS 227.7202-3(a) 
(June 1995), or the Restricted Rights provisions of FAR 52.227-14 (June 1987) and FAR 
52.227-19 (June 1987), as applicable. 

 
11. GENERAL  

(a) No action arising out of any claimed breach of this Agreement or transactions under this Agreement 
may be brought by Customer more than two years after the cause of such action has arisen. 

(b) Customer may not assign, sell, sublicense or otherwise transfer this Agreement, the license 
granted herein or the Software or User Documentation by operation of law or otherwise without 
the prior written consent of PCA. Any attempt to do any of the foregoing without PCA’s consent 
is void.  

(c) Customer acknowledges that the Software, User Documentation and other proprietary information 
and materials of PCA are unique and that, if Customer breaches this Agreement, PCA may not 
have an adequate remedy at law and PCA may enforce its rights hereunder by an action for 
damages and/or injunctive or other equitable relief without the necessity of proving actual damage 
or posting a bond therefor. 

(D) THE RIGHTS AND OBLIGATIONS UNDER THIS AGREEMENT SHALL NOT BE 
GOVERNED BY THE UNITED NATIONS CONVENTION ON CONTRACTS FOR THE 
INTERNATIONAL SALE OF GOODS, THE APPLICATION OF WHICH IS EXPRESSLY 
EXCLUDED, BUT SUCH RIGHTS AND OBLIGATIONS SHALL INSTEAD BE GOVERNED 
BY THE LAWS OF THE STATE OF ILLINOIS, APPLICABLE TO CONTRACTS ENTERED 
INTO AND PERFORMED ENTIRELY WITHIN THE STATE OF ILLINOIS AND 
APPLICABLE FEDERAL (U.S.) LAWS. UCITA SHALL NOT APPLY TO THIS 
AGREEMENT.  

(E) THIS AGREEMENT SHALL BE TREATED AS THOUGH IT WERE EXECUTED IN THE 
COUNTY OF COOK, STATE OF ILLINOIS, AND WAS TO HAVE BEEN PERFORMED IN 
THE COUNTY OF COOK, STATE OF ILLINOIS. ANY ACTION RELATING TO THIS 
AGREEMENT SHALL BE INSTITUTED AND PROSECUTED IN A COURT LOCATED IN 
COOK COUNTY, ILLINOIS. CUSTOMER SPECIFICALLY CONSENTS TO 
EXTRATERRITORIAL SERVICE OF PROCESS.  

(f) Except as prohibited elsewhere in this Agreement, this Agreement shall be binding upon and inure to 
the benefit of the personal and legal representatives, permitted successors, and permitted assigns 
of the parties hereto.  
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(g) All notices, demands, consents or requests that may be or are required to be given by any party to 
another party shall be in writing. All notices, demands, consents or requests given by the parties 
hereto shall be sent either by U.S. certified mail, postage prepaid or by an overnight international 
delivery service, addressed to the respective parties. Notices, demands, consents or requests 
served as set forth herein shall be deemed sufficiently served or given at the time of receipt 
thereof.  

(h) The various rights, options, elections, powers, and remedies of a party or parties to this 
Agreement shall be construed as cumulative and no one of them exclusive of any others or of any 
other legal or equitable remedy that said party or parties might otherwise have in the event of 
breach or default in the terms hereof. The exercise of one right or remedy by a party or parties 
shall not in any way impair its rights to any other right or remedy until all obligations imposed on 
a party or parties have been fully performed. 

(i) No waiver by Customer, PCA or Dealer (if any) of any breach, provision, or default by the other 
shall be deemed a waiver of any other breach, provision or default.  

(j) The parties hereto, and each of them, agree that the terms of this Agreement shall be given a neutral 
interpretation and any ambiguity or uncertainty herein should not be construed against any party 
hereto. 

(k) If any provision of this Agreement or portion thereof is held to be unenforceable or invalid by any 
court or competent jurisdiction, such decision shall not have the effect of invalidating or voiding 
the remainder of this Agreement, it being the intent and agreement of the parties that this 
Agreement shall be deemed amended by modifying such provision to the extent necessary to 
render it enforceable and valid while preserving its intent or, if such modification is not possible, 
by substituting therefor another provision that is enforceable and valid so as to materially 
effectuate the parties’ intent.  

Except as set forth herein, this Agreement may be modified or amended only by a written instrument 
signed by a duly authorized representative of PCA and Customer. 
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Chapter 1 
Introduction 

Terms 
The following terms are used throughout this manual. A brief explanation is given 
to help familiarize you with them. 

 
Windows refers to the Microsoft Windows environment version 3.1 or 

higher. 
 

[ ] indicates metric equivalent 
 

Click on means to position the cursor on top of a designated item or 
location and press and release the left-mouse button (unless 
instructed to use the right-mouse button). 
 

Double-click on means to position the cursor on top of a designated item or 
location and press and release the left-mouse button twice in 
quick succession. 
 

 



 

Conventions 
To help you locate and interpret information easily, the pcaColumn manual 
adheres to the following text format. 

Italic indicates a glossary item, or emphasizes a given word or 
phrase. 

Bold indicates the name of a menu or a menu item command such 
as File or Save. 

Mono-space indicates something you should enter with the keyboard. For 
example “c:\*.txt”. 

KEY + KEY indicates a key combination. The plus sign indicates that you 
should press and hold the first key while pressing the second 
key, then release both keys. For example, “ALT + F” 
indicates that you should press the “ALT” key and hold it 
while you press the “F” key. then release both keys. 

System requirements 
To use pcaColumn, a personal computer running Microsoft Windows 98 or later is 
required. pcaColumn needs less than 10 MB of disk space to install. 

Program Capacity 
• 500 reinforcing bars within a section.  

• 500 exterior points that define the geometric outline of the cross section 
(pcaSection module).  

• 500 interior points that define an opening in the cross section (pcaSection 
module).  

• 4000 factored load entries, each consisting of an axial load, a moment about 
the x-axis, and a moment about the y-axis.  

• 50 service load entries, each consisting of dead, live, wind and earthquake 
axial loads, moments at column top about the x and y axes, and moments at 
column bottom about the x and y axes. 

• 20 load combinations. 
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Installing pcaColumn 
1. If you have the installation disk please insert it into the CD drive and proceed 

to step 2. If you do not have the installation disk but downloaded the 
installation file from our website, please run the file and proceed to step 3. 

2. If the installation does not start automatically after inserting the installation 
disk to the CD drive then please run the file install.exe from the installation 
disk and proceed to step 3. If the installation starts automatically then please 
follow the instructions on the screen. You may be asked which product you 
want to install if you received pcaColumn together with other software from 
pcaStructurePoint. 

3. The installation process starts by displaying the following window (Figure 1-
1). Please read all the information. Then press the NEXT button. This will 
continue the installation process by installing license manager, an evaluation 
license, and the application software. 

 
Figure 1-1. Beginning of the installation 

4. The first step of the application installation process is to review the software 
license agreement as shown in Figure 1-2. Please read all the information 
carefully. Press the I AGREE button to confirm that you have read and agreed 
with it. This will continue the installation. If you do not agree with the license 
agreement press the I DO NOT AGREE button. This will stop the installation. 
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Figure 1-2. License agreement 

5. If you continue the installation then please read the latest information of the 
software included in the readme file (Figure 1-3). Having read all the 
information press the NEXT button. 

 
Figure 1-3. Readme file 

6. In the next step please provide the user’s name and company. Press next when 
you are ready to proceed. 
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Figure 1-4. Registration information 

7. The next setup is to decide the directory where pcaColumn is to be installed as 
shown in Figure 1-5. The default directory is C:\Program 
Files\PCA\pcaColumn. You may press the BROWSE button to locate the 
directory. If the directory does not exist, the setup program will create it. Press 
the NEXT button to go to the next step. 

 
Figure 1-5. Choose Destination Location 

8. The next step is to enter the group name as shown in Figure 1-6. Windows 
will use this name in the Start/Programs menu. Press the NEXT button to go 
to the next step. 
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Figure 1-6. Select Program Manager Group 

9. After all the previous steps are completed, press the NEXT button as shown in 
Figure 1-7 to start the installation. 

 
Figure 1-7. Start Installation 

10. During the installation a window as in Fig. 1-8 shows the progress as files are 
copied to your hard drive. 
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Figure 1-8. Installation progress 

11. After the installation is completed, a dialog box similar to Figure 1-9 is 
shown. Press the FINISH button to finish the installation. 

 
Figure 1-9. Installation Complete 

Purchasing and Licensing Process 

Licensing Model 
By default, each pcaStructurePoint software application comes in an Evaluation 
mode. This means that initially our products can be used for a limited time of 15 
days. If the user decides to purchase the software license, and completes the 
purchase, pcaStructurePoint will provide a License Code. By entering this code, 
user will activate the software license. Once the software license is activated the 
application will no longer have restrictions limiting the time of operation. 
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Evaluation Mode 
This is the default mode of the license. In this licensing scheme, users are granted 
limited rights to use our full-featured software. The only visible difference 
between the evaluation version and the licensed version is an additional start-up 
dialog box as shown in Figure 1-10. It gives a choice of buying the software, 
entering the activation code or running the application in the evaluation mode by 
pressing the EVALUATE button. Evaluation mode is available for a limited time 
only. By default, pcaStructurePoint software applications come with 15 days. That 
means, from the day of installation, a user can evaluate the software for the next 15 
days. After this time, user will either obtain a License, or uninstall the application. 

Note: Any tampering with system clock or evaluation license file will render 
the software useless. 

 
Figure 1-10. Start-up Dialog Box 

How to Purchase 
You may purchase the license on-line at www.pcaStructurePoint.com or by calling 
our Sales Department at 847-972-9042. To buy on-line you may press BUY NOW 
button, which will run your default web browser and open the product web page 
where you will be able to complete the transaction. 

Licensing Activation 
After the purchase is completed, pcaStructurePoint will generate a unique 
Activation Code based on the product ID and the locking code, which is derived 
from the unique hardware-id of the user’s computer. Each License is associated 
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with the particular PC in which user has installed the pcaStructurePoint software. 
This implies that the activation-code will not work on any other PC. You can 
transfer the license to another PC by contacting pcaStructurePoint for the transfer 
procedures. 

To activate the license press the LICENSE ACTIVATION button in the start-up 
dialog box. This will bring a window as in Figure 1-11, which shows three license 
activation methods.  

 
Figure 1-11. License activation methods 

If you have already received the license code you may choose ENTER LICENCE 
CODE and then press the NEXT button. A window (Figure 1-12) will pop up 
where you will be able to type in the license code. However, in order to avoid 
mistyping we advise to use copy and paste feature instead of typing the code. 
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Figure 1-12. Enter license code 

The license code can also be extracted from a file. To do that press the BROWSE 
button  and open the file in which the license code is stored using the open 
window (Figure 1-13). 

 
Figure 1-13. Open activation file 

If the entered code is correct the license will be activated and window as in Figure 
1-14 will show. When you press the FINISH button the license activation will be 
completed. 
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Figure 1-14. Activation completion 

If you do not have the license code you may chose either TELEPHONE or E-
MAIL method, whichever is more convenient for you. Please note that for E-
MAIL method you need to have the Internet connection and a default mailer 
configured in your system. 

Activation by Phone 
If the telephone method was chosen to activate the license the following screen 
appears (Figure 1-15). It shows the product ID and the Locking Code.  

 
Figure 1-15. Activation by phone 
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This information is needed when you make a phone call at 847-966-4357 (HELP) 
to obtain the license. You will be asked to provide information about yourself in 
order to verify that you have purchased the license. 

Activation by E-mail 
If the e-mail method was chosen to activate the license a screen (Figure 1-16) will 
show prompting you to provide information about yourself. When you type in all 
the information press the SEND E-MAIL button and it will be automatically e-
mailed to us together with the product ID and the Locking Code. After the 
information is verified the license code will be generated and e-mailed back to 
you.  

 
Figure 1-16. Activation by e-mail 

After you receive it you may enter it by pressing the LICENSE ACTIVATION 
button in the start up dialog box (Figure 1-10) and choosing ENTER LICENSE 
CODE option. . If the entered code is correct, the license will be activated and 
window as in Figure 1-14 will show. When you press the FINISH button the 
license activation will be completed. 
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Chapter 2 
Method of Solution 

pcaColumn enables the user to compute the capacity of (investigate) or design 
reinforced concrete column sections. The section under consideration may be 
subject to a combination of loadings consisting of combined axial loads and 
uniaxial or biaxial moments.  

In pcaColumn, the section may be rectangular or circular with any reinforcement 
layout. Material properties for the concrete and reinforcing steel are user-
controlled. The applied loading consists of tensile or compressive axial loads 
acting alone or combined with uniaxial or biaxial bending.  

At the user’s option, the program may investigate the slenderness effects on 
a column using the approximate method described in the design code. If 
applicable, the program computes the magnification factors to be applied to the 
moment(s).  

With the pcaSection module, pcaColumn can investigate irregularly-shaped 
sections. An irregular section is defined as a closed polygon and may even contain 
an opening (hollow section).  

pcaColumn conforms to the provisions of the following design specifications: 
Building Code Requirements for Structural Concrete (ACI 318-02), published by 
the American Concrete Institute, Farmington Hills, MI.  

Design of Concrete Structures (A23.3-94), published by the Canadian Standards 
Association, Ontario, Canada 

 



 

A – Definitions and Assumptions 
1. The analysis of the reinforced concrete section conforms to the provisions of 

the Strength Design Theory.  

a) All conditions of strength satisfy the applicable conditions of equilibrium 
and strain compatibility.  

b) Strain in the concrete and in the reinforcement is directly proportional to 
the distance from the neutral axis.  

c) The maximum usable (ultimate) strain at the extreme concrete 
compression fiber is assumed equal to 0.003 (0.0035 for CSA) unless 
otherwise specified by the user.  

d) A uniform rectangular concrete stress block is used. For ACI code, the 
maximum uniform concrete compressive stress, , is  and the 
block depth is 

cf
'85.0 cf

c1β , where  is the distance from the extreme 
compression fiber to the neutral axis and 

c

1β , is described in item 4 
below. Both  and cf 1β  may be modified by the user. For CSA, is 
taken as: 

cf

( ) ''' 67.00025.085.0 cccc ffff ≥−= , where '  is in MPa cf

e) Concrete displaced by the reinforcement in compression is deducted from 
the compression block. 

c

N.A.

εu

εs

β 1c

cf

 
Figure 2- 1. Analysis of Reinforced Section 
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f) For the reinforcing steel, the elastic-plastic stress-strain distribution is 
used. Stress in the reinforcing steel below the yield strength, , is 
directly proportional to the strain. For strains greater than that 
corresponding to the yield strength, the reinforcement stress remains 
constant and equal to . 

yf

yf

g) Tensile strength of concrete is neglected. 

fStress, y

fy

ε

 
Figure 2-2. Elastic-Plastic Stress-Strain Reinforcement Curve 

2. The modulus of elasticity of concrete, , is computed as follows (unless 
otherwise specified by the user): 

cE

'000,57 cc fE = , where  and  are in psi, '
cf cE

'700,4 cc fE = , where  and  are in MPa. '
cf cE

For the CSA standard, 355,7518,3 ' += cc fE , where '  and  are in MPa. cf cE

3. The modulus of elasticity of reinforcing steel, , is taken as 29,000 ksi 
(200,000 MPa) unless otherwise specified by the user. 

sE

4. The ratio of the concrete compression block depth to the distance between the 
extreme compression fiber and the neutral axis, 1β , is computed as follows 
(unless otherwise specified by the user): 

85.005.005.165.0 '
1 ≤−=≤ cfβ , where  is in ksi, '

cf

εy

Strain, s
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85.0007143.00643.165.0 '
1 ≤−=≤ cfβ , where  is in MPa. '

cf

For CSA: , where  is in MPa. 67.00025.097.0 '
1 ≥−= cfβ '

cf

5. Stress in the reinforcement is computed based on the strain at the centroid of 
each reinforcing bar. 

6. All moments are referenced to the geometric centroid of the gross concrete 
section (neglecting the reinforcement). 

7. For the ACI code, the nominal (unreduced) strength of the section is first 
computed on the basis of the strength of materials. This is then reduced to the 
design strength using the capacity reduction factors.  

The following reduction factors are used for the ACI code: 

aφ is the reduction factor for pure axial compression, 

bφ  is the reduction factor for tension-controlled failure, 

cφ  is the reduction factor for compression-controlled failure. 

Compression-controlled failure and tension-controlled failure are defined in 
clauses 10.3.3 and 10.3.4 respectively. Reduction factor, φ , is assumed to 
vary linearly with the tensile strain in the extreme tension steel for failure 
cases falling between the limits of the compression-controlled and the tension-
controlled cases. 
For the CSA standard, the following factors are used: 

aφ  is the reduction factor for pure axial compression, 

sφ  is the material resistance factor for steel, 

cφ  is the material resistance factor for concrete. 

8. If the reinforcement ratio falls below the code-specified minimum of 1%, the 
program has two options: consider the section as Structural or Architectural. 
For Architectural, the maximum concrete stress, , is multiplied by the 
reinforcement ratio. This produces the same effect as reducing the concrete 
area to achieve a reinforcement ratio of 1%. For Structural, the specified 
concrete stress is used. 

cf

9. Under the Design option, the reinforcement ratio cannot be less than 0.5%. 
Under the Investigation option, any value can be used for the reinforcement 
ratio. 

2-4  Method of Solution 



 

nominal strength
design strength

co
m

pr
es

si
on

te
ns

io
n

φa

cP

φc cP

φc cP

tP
φb tP

oM

P

M

oMφb

Tesion control limit

Compression control limit

 
Figure 2-3. Reduction factors for Flexure and Axial Loads per ACI code 

B – Sign Convention 
1. Looking at the section in plan, the positive x-axis points to the right and the 

positive y-axis points up. 

2. Positive axial loads are compressive and negative axial loads are tensile.  

3. The right-hand rule is used to determine the compression and tension faces of 
the section. A positive moment about the x-axis, , produces tension at the 
top face of the section and compression at the bottom face. A positive moment 
about the y-axis, , produces tension at the left face of the section and 
compression at the right face. 

xM

yM
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Figure 2-4. pcaColumn's positive local coordinate system 

4. If service loads are input, moments at the upper (top) and lower (bottom) ends 
of the column are needed. Top and bottom moments of opposite signs produce 
single curvature bending. Top and bottom moments of the same sign produce 
double curvature bending.  

 
In the global coordinate system, the section at the upper end of the column 
coincides with pcaColumn’s local coordinate system where positive moments 
about the y-axis produce tension on the left side of the section. However, the 
global coordinate system produces an opposite effect on the section at the 
lower end of the column where positive moments about the y-axis produce 
tension on the right side of the section. Since pcaColumn assumes the 
reinforcement pattern to be constant throughout the column height, the 
program internally changes the sign of the service moments at the lower end 
to convert from the global coordinate system to the local.  

5. For uniaxial runs, the factored moments considered always produce positive 
bending on the section as described in item 3 above. This is valid for the cases 
when the section is symmetrical about the run axis. If the column bends in 
double curvature and the section is not symmetrical, a biaxial investigation 
run is recommended. 
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Figure 2-5. pcaColumn's positive global system 

C – Section Investigation 
1. The computations performed when investigating a section depend on the 

selected load mode: 

a) Factored loads - for the axial load of each load point, the moment 
capacity and the ratio of design-to-applied moment are computed. For a 
biaxial run, the computed  and  moment capacities are at the 
same angle as that produced by the applied  and  moments.  

xM yM

xM yM

b) Service loads - the program computes the factored loads using the input 
load combinations. If slenderness effects are to be checked and the 
column is found to be slender, the applied moments are magnified 
according to Procedures E and F. For each factored load, the same 
computations described in (a) above are performed.  
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Figure 2-6. Interaction Surface for Combined Load and Biaxial Bending 
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c) Control points - for several key points on the interaction diagram, the 
axial load, corresponding moment capacity and the corresponding neutral 
axis depth are computed. The key points are: pure compression, 
maximum compression, point where steel stress is zero, point where steel 
stress is 0.5 , balanced point, pure flexure and pure tension. For ACI 
code, an additional control point is introduced where maximum steel 
strain is equal to 0.005 (tension control limit). 

yf

d) Axial loads – for each input axial load, the moment capacity and the 
corresponding neutral axis depth are computed.  

2. The program also computes the interaction diagram (uniaxial runs) or the 
three-dimensional failure surface (biaxial runs) of the input section. The 
values of pure compressive axial load capacity and pure tensile axial load 
capacity are computed. These two values set the range within which the 
moment capacities are computed. A predetermined number of axial load 
values (within this range) are computed.  

a) For uniaxial runs, the moment capacity about the selected axis only is 
computed. The moment capacity about the orthogonal axis is ignored. To 
compute the moment capacity at a certain level of axial load, the neutral 
axis angle is held constant, parallel to the selected axis. The neutral axis 
depth is adjusted to arrive at the desired axial load capacity. This is done 
for all the predetermined values of axial load.  

b) For biaxial runs, the same predetermined values of axial load are utilized. 
For each level of axial load, the section is rotated in 10-degree increments 
from 0 degrees to 360 degrees and the Mx and My moment capacities are 
computed. Thus for each level of axial load, an Mx-My contour is 
developed. Repeating this for the entire range of axial loads, the three-
dimensional failure surface is computed. 

D – Section Design 
1. Based on the specified minimum, maximum and increment specified for the 

section and the reinforcing bars, the program selects the smallest section with 
the least amount of reinforcement for which the load-moment capacity 
exceeds the applied loads. If service loads are input, they are factored using 
the input load combinations. Depending on the design criteria the user selects, 
the least amount of reinforcement the program searches for means either the 
smallest number of bars or the smallest steel area. 
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2. The program starts the design by trying the smallest section (minimum 
dimensions) and the least amount of reinforcing bars. The program verifies 
that the ratio of provided reinforcement is always within the specified 
minimum and maximum ratios. Furthermore, the bar spacing is always kept 
greater than or equal to the larger of 1.5 times the bar diameter or 1.5 in. [40 
mm] (unless otherwise specified by the user). 

3. A section fails the design if, for the design axial load, the ratio of design-to-
applied moment is less than 1.0 (unless otherwise specified in the Design 
Criteria box).  

4. Once a section passes the design, its capacity is computed and the 
computations explained in Procedure C above are performed. 

E – Moment Magnification (Slenderness Effects) for Non-Sway Columns 
1. If properties of framing members are input, pcaColumn computes the non-

sway condition effective length factor, , as the smaller of:  bk

( )BA ψψ ++ 05.07.0  

min05.07.0 ψ+  

Where ψ  is the ratio of ( )LEI /Σ  of columns to ( )LEI /Σ  of beams in 
a plane at one end of the column, Aψ  and Bψ  are the values of ψ  at the 
upper end and the lower end of the column, respectively, and minψ  is the 
smaller of Aψ  and Bψ . 

The value of must always be between 0.5 and 1.0. The moment of inertia 
used in computing 

bk
ψ  is the gross moment of inertia multiplied by the cracked 

section coefficients (specified in the Slenderness Factors box). 

2. The smaller and larger factored column end moments  and , 
respectively, are computed.  is positive if the column is bent in single 
curvature and is negative if the column is bent in double curvature.  is 
always positive.  

1M 2M

1M

2M

3. For the ACI code, slenderness effects will be considered if  
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where  is the unsupported column length and ul A
I

r g=  is the radius of 

gyration. The ratio  is always greater than or equal to -0.5. 21 / MM

4. If the ratio  exceeds 100, slenderness effects using this approximate 
procedure cannot be applied. A more exact method must be used. In this case, 
the procedure is aborted and a message is issued. 

rlk ub /

5. The factor  is computed as: mC

4.04.06.0
2

1 ≥+=
M
MCm . 

6. The factor dβ  is computed as the ratio of maximum factored axial dead load 
to the total factored axial load for the load combination under consideration. 

7. The quantity ( )sesgc IEIE +2.0  is determined; where  is the modulus of 
elasticity of concrete, is the modulus elasticity of steel, is the gross 
moment of inertia of the concrete section, and  is the moment of inertia of 
reinforcement. The product 

cE

sE gI

seI
EI  is computed as: 

d

sesgc IEIE
EI

β+

+
=

1
2.0

. 

8. The critical buckling load, , is computed as: cP

2

2

)( lk
EIP

b
c

π
= . 

9. The non-sway moment magnification factor, bδ , is computed as: 
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where the stiffness reduction factor, kφ , is taken as 0.75 (may be modified 
using the Slenderness Factors box) and  is the factored axial load for the 
load combination under consideration. 

uP

10. The moment due to minimum eccentricity, , is computed as: mine

minumin ePM = , where 

hemin 03.06.0 += , with  in in, h

hemin 03.015 += , with  in mm, h

and  is the section dimension (diameter for circular sections) in the direction 
being considered.  

h

11. The magnified moment,  is the larger of cM 2Mnsδ  or minnsMδ . 

F – Moment Magnification (Slenderness Effects) for Sway Columns 
1. If properties of framing members are input, pcaColumn computes the sway 

condition effective length factor, , using the following simplified 
equations:  

sk

if both ends are restrained and 2<mψ , ( ) 0.112005.0 ≥+−= mmsk ψψ , 

if both ends are restrained and 2≥mψ , 0.119.0 ≥+= msk ψ ,  

if the upper end is hinged, Bsk ψ3.02 += , 

if the lower end is hinged, Ask ψ3.02 += , 

if both ends are hinged, 30=sk . 

 
Where ψ  is the ratio of ( )LEI /Σ  of columns to ( )LEI /Σ  of beams in 
a plane at one end of the column, Aψ  and Bψ are the values of ψ  at the upper 
end and the lower end of the column, respectively, and mψ  is the average of 

Aψ  and Bψ .  
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An end is determined to be hinged if its ψ  is very large. This happens in the 
case where ( )LEI /Σ  of beams is too small (or zero) relative to the  
of columns at that end. In this case, the program outputs 999.9 for the value of 

( )LEI /Σ

ψ . The moment of inertia used in computing ψ  is the gross moment of 
inertia multiplied by the cracked section coefficients (specified in the 
Slenderness Factors box).  

2. The smaller and larger factored non-sway column end moments  
and , respectively, are computed. These are factored moments due to dead 
and live loads.  is positive if the column is bent in single curvature and is 
negative if the column is bent in double curvature. is always positive. 

bM1

bM 2

bM1

bM 2

3. The smaller and larger factored sway column end moments  and , 
respectively, are computed. These are factored moments due to lateral loads 
(wind and earthquake). is positive if the column is bent in single 
curvature and is negative if the column is bent in double curvature. is 
always positive. 

sM1 sM 2

sM1

sM 2

4. For the ACI code, slenderness effects will be considered if . For 
the CSA standard, all sway columns are designed for slenderness effects. 

0.22/ ≥rlk us

5. If the ratio  exceeds 100, slenderness effects using this approximate 
procedure cannot be applied. A more exact method must be used. In this case, 
the procedure is aborted and a message is issued. 

rlk us /

6. The quantity ( )sesgc IEIE +2.0  is determined; where  is the modulus of 
elasticity of concrete,  is the modulus elasticity of steel,  is the gross 
moment of inertia of the concrete section, and  is the moment of inertia of 
reinforcement. The product EI is computed as: 

cE

sE gI

seI

sesgc IEIEEI += 2.0 . 

7. The critical buckling load, , is computed as: cP

( )2

2

us
c lk

EIP π
= . 

8. The sway moment magnification factor, sδ , is computed as: 
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where the stiffness reduction factor, kψ , is taken as 0.75. 

uPΣ  is taken as the factored axial load for the load combination under 
consideration times the ratio uu PP /Σ . 

cPΣ  is taken as the critical buckling load for the load combination under 
consideration times the ratio cc PP /Σ . 

kφ  and the ratios uu PP /Σ  and cc PP /Σ  may be modified using the 
Slenderness Factors box.  

9. If 
gc

uu

Af
P

r
l

'/35≤  , the magnified moment is computed as: 

ssbc MMM 111 δ+= , 

ssbc MMM 222 δ+= . 

10. If 
gc

uu

Af
P

r
l

'/35> , the braced moment magnification factor, bδ , is computed 

according to steps 1 through 9 as described in Procedure E above. In step 7, 
however, dβ  is computed for the load combination under consideration. The 
magnified moment is computed as: 

( )ssbbc MMM 111 δδ += , 

( )ssbbc MMM 222 δδ += . 
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G – Output notation 
The following table explains some of the notations used in the output of the 
program: 
 

Notation 
 

ACI Code CSA Standard

uP  Ultimate factored axial load ( ) uP Factored axial load ( ) fP

uM  Ultimate factored moment ( ) uM Factored moment ( ) fM

nMf  Moment capacity ( nMψ ) Factored moment of 
resistance ( ) rM
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Chapter 3 
The pcaColumn Window 

Most windows have certain elements in common, such as a title bar and menus. 
Not all windows, however, have every element. To learn more about how to use 
window elements, refer to your Microsoft Windows manual. The following is a list 
of the pcaColumn window components. 

 

Control-Menu Box: 
The Control-menu box is located in the upper-left corner of the window and 
includes commands for sizing, moving, enlarging, restoring, and closing the 
window, as well as switching to other applications. To access the Control-menu 

 



 

box using the mouse, click the left mouse button on the box; using the keyboard, 
press ALT+ - (hyphen). 

Title Bar:  
The Title bar displays the name of the application (pcaColumn in this case), along 
with the name of the current data file in use. If the data have not been saved into a 
file, the word Untitled is displayed in the Title bar.  

Menu Bar:  
The Menu bar is located directly below the Title bar. It lists the available menus. A 
menu contains a list of commands or actions you can execute.  

Tool Bar:  
The Tool bar is located directly below the Menu bar. It contains a collection of 
buttons (or icons) that provide a shortcut to accessing the menu commands. The 
Tool bar buttons can only be accessed using the mouse.  

Information Bar:  
The Information bar is located on the left side of the pcaColumn window. The top 
part displays the column cross section. The bottom part is a list of selected input 
data echo.  

Graphics Area:  
The Graphics area covers most of the window. This is where the interaction 
diagram is shown.  

Status Bar:  
The Status bar is located along the bottom of the window. It displays important 
information such as units, design code, cursor position, and helpful messages. 

Using the Menus 
To access a menu item using the mouse, point to the menu item and click the left-
mouse button. Each menu item can also be selected with the keyboard by 
simultaneously pressing the ALT key and the underlined letter of the menu you 
want to open. For example, to open the File menu, press ALT + F.  

To close a menu without selecting a command, point to any blank area on the 
screen and click the left-mouse button, or press ESC.  
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To choose a command from a selected menu, point to that command and click the 
left-mouse button, or use the UP and DOWN ARROW keys until you reach the 
command and press ENTER. 

Menu Conventions  
The following menu conventions are used in pcaColumn. 

Menu convention Meaning 
 
Dimmed (or not visible) command. 

 
The command is not available at the 
current time. 

An ellipsis (…) following a command. When the command is selected, a 
dialog box will appear, requesting 
data input or listing options to select 
from. 

A check mark (✔) next to a command. The command is in effect. When the 
check mark is removed (by selecting 
the command), the command is no 
longer in effect. 

Using a Dialog Box 
A dialog box is displayed to request information or to supply you with 
information. An ellipsis (…) after a menu command indicates a dialog box will 
appear when that command is elected. For example, if you choose the Open 
command from the File menu, the OPEN dialog box appears. In this dialog box, 
specify the name of the file you want to open. 

Command Button:  
The Command button (or Push button) is labeled to do exactly what it says. The 
OK and CANCEL buttons are common command buttons. A command button 
followed by an ellipsis (…) opens another dialog box. The currently selected 
button has a darker border than other buttons. You can choose the selected button 
by pressing ENTER.  

Option Button:  
The Option button (or Radio button) is one of a group of related options in which 
you can select only one. When an option is selected, the selected option button 
contains a black dot. To select an option with the mouse, click the mouse button on 
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the option you want, or using the keyboard, press TAB to move to the group of 
options you want and use the arrow keys to select the option button.  

Check Box:  
The Check box is an option that can be turned on or off. Unlike option buttons, 
you can turn on as many check boxes as you want, even if they are in a group. 
When a check box is turned on, an “X” appears in the box. If you are using a 
mouse, click a blank check box to select it or click a selected check box to clear it. 
If you are using a keyboard, press TAB to move to the check box. Press the 
SPACEBAR to select the box. Press the SPACEBAR again to clear the selection.  

Text Box:  
The Text box is where data or information is entered. When you move into an 
empty text box, an insertion point (flashing vertical bar) appears. The text you type 
starts at the insertion point. If the box already contains text, it is selected and any 
text typed replaces it. You can also delete the existing text by pressing DEL or 
BACKSPACE.  

List Box:  
A List box displays a list of choices. If there are more choices than can fit in the 
box, scroll bars are provided so you can move quickly through the list. To select an 
item from a list box, click the scroll arrows until the item you want to select 
appears in the list box, then click on that item. If you are using the keyboard, use 
the arrow keys to scroll to the item you want.  

Drop-Down List:  
A Drop-down list appears initially as a rectangular box with the current selection 
marked. To see a list of available choices, click the arrow at the right of the box or 
press ALT + DOWN ARROW to open the box. You can now select another item 
by scrolling as you do with a list box.  

Working with a List Box 
A list box displays a list of choices or items. If there are more choices than can fit 
in the box, scroll bars are provided. The scroll bar is usually located to the right 
(vertical scroll bar) or at the bottom (horizontal scroll bar) of a list box. 
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To select a single item from a list box:  
• Click the scroll arrows until the item you want to select appears in the list box. 

Click the item.  

• Using the keyboard, use the UP or DOWN arrow key to scroll to the item you 
want.  

To select multiple sequential items in a list:  
• Click the first item you want to select and then drag the cursor to the last item 

you want to select. Alternatively, click on the last item you want to select. 
Both items, and all items in between, are selected. To cancel the selections, 
release the SHIFT key and click any item.  

• Using the keyboard, use the UP ARROW or DOWN ARROW key to move 
the cursor to the first item you want to select. Press and hold down the SHIFT 
key. Continue to press the arrow key repeatedly until all the items you want 
are selected. To cancel the selections, release the SHIFT key and press one of 
the arrow keys. 

To select multiple non-sequential items in a list:  
• Press and hold down the CTRL key, and click each item you want to select. 

To cancel a selection, press and hold down the CTRL key, and click the item 
again. There are no keyboard equivalents for this procedure. 

File Menu 
The File menu is used for working with data files, printing results, and exiting the 
program.  

New (CTRL+N) 
Clears any input data and returns the data to the default values so that a new data 
file may be input. 

Open (CTRL+O) 
Opens an existing pcaColumn data file.  

Save (CTRL+S) 
Saves the changes you have made to the current data file under that same filename.  
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Save As 
Names or renames a data file.  

Import (CTRL+I) 
Reads geometry, reinforcement or loads data from an ASCII (Text) file.  

Revert  
Discards any changes to the data and returns to the last version of saved data. This 
option will only be available if the file has been modified since the last file save.  

Print Results 
Displays Print dialog box and prints the results in the text form to the selected 
printer. 

Print Screen 
Displays Print dialog box and prints the results similarly as they appear on the 
screen. 

Recent Data File List 
Provides quick access to up to four previously open data files. 

Exit  
Quits the pcaColumn program. If you have made any changes to your data and 
have not saved them, pcaColumn will prompt you whether you want to save or 
abandon any changes you have made before you exit. 

Input Menu  
The Input menu includes commands used to input the data needed to define 
a problem.  

General Information  
Input labels to identify the input and select from several options that control the 
run.  

Material Properties  
Input the material properties for concrete and reinforcement.  
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Section  
Rectangular: Input the dimensions of a rectangular section. 

Circular: Input the dimension of a circular section. 

Irregular: Execute pcaSection to define an irregularly shaped section. 
See Chapter 6. 

Reinforcement  
All Sides Equal: Input a reinforcement pattern in which all the bars are of one 
size, and the number of bars is the same on all four sides of a rectangular layout or 
are equally spaced for a circular layout. Available for rectangular and circular 
sections. 

Equal Spacing: Input a reinforcement pattern in which all bars are of one size and 
are uniformly spaced on all four sides of a rectangular layout. Available for 
rectangular sections only. 

Sides Different: Input a reinforcement pattern in which each one of the four sides 
of a rectangular section has a certain number of bars and a certain bar size. 
Available for rectangular sections only. 

Irregular Pattern: Input a reinforcement pattern in such a way that bars of any 
size can be placed anywhere within the column section. 

Confinement: Input confinement-related data such as the capacity reduction 
factors and the size of ties associated with the longitudinal bar size. 

Design Criteria: Input parameters that govern the design of the section such as 
column type, minimum and maximum reinforcement ratio, bar selection criterion, 
minimum clear spacing, and design/required ratio. 

Slenderness  
Design Column: Input data needed for slenderness related to the column being 
considered. 

Column Above/Below: Input data needed for slenderness related to the columns 
above and below the design column. 

X-Beams: Input data needed for slenderness related to beams perpendicular to the 
x-axis framing into the design column. 

Y-Beams: Input data needed for slenderness related to beams perpendicular to the 
y-axis framing into the design column. 
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Factors: Input factors that affect slenderness calculations. 

Loads  
Factored: Input factored axial loads and moments. This command is available for 
non-slender columns only. 

Service: Input service-level (dead, live, wind and earthquake) axial loads and 
moments about the active axis. Moments are input at the top and at the bottom of 
the column. This command must be used for slender columns. 

Control Points: If chosen, the program will compute key points on the interaction 
diagram. In addition, the splice regions are shown on the interaction diagram. This 
option is available for short (non-slender) columns under the investigation option 
only. 

Axial Loads: Input a group of axial loads with an initial value, a final value, and 
an increment. This command is available for uniaxial short (non-slender) columns 
only. 

Load Combinations: Input the load factors and combinations used to combine the 
service loads.  

Flip/Rotate Section  
Flip an unsymmetrical section about an axis or rotate an irregular section (created 
in pcaSection). 

Solve Menu  
The Solve menu contains commands used to perform the design or investigation, 
trace through the design process, and send the output to a text file.  

Execute (F5)  
Executes the solver.  

Design Trace  
Toggles trace-through-a-design On and Off.  

Results File  
Toggles output-to-results-file On and Off. 
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View Menu 
The View menu commands used to customize the display screen to suit your 
viewing needs, view the interaction diagram at a given angle, view the contour for 
a given axial load, superimpose an interaction diagram or a contour from another 
run, and view the results file.  

Redraw  
Redraws the displayed diagram or contour and clear any superimposed curves. 

Copy Diagram to Clipboard (CTRL+C) 
Copies the displayed diagram or contour to clipboard so that in can be pasted in 
other applications. 

Information Bar  
Shows or hides the Information bar.  

Tool Bar  
Shows or hides the Tool bar.  

Status bar  
Shows or hides the Status bar.  

Grid  
Shows or hides the grid.  

Mx-My Diagram  
View a contour of the failure surface sliced at a constant axial load.  

P-M Diagram 
View an interaction diagram sliced at a constant (Mx, My) angle.  

Superimpose  
Superimpose a diagram from a previously saved run over the current diagram.  
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Results (F6) 
View the results file after a successful run has been performed with the 
Solve | Results File option ON. 

Options 
The Options menu contains commands used to view or change pcaColumn’s 
default settings and reinforcing bar database. 

Startup defaults 
View or Edit application startup default settings. 

Rebar database 
View or Edit reinforcing bar database. 

Help Menu  

Contents and Index  
Lists all the available help topics about the program.  

Using Help  
Provides help on using the Microsoft Windows help system.  

About  
Displays copyright information and the version number of the program. 
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Chapter 4 
Operating the Program 

This chapter is divided into sections that follow the order in which commands and 
options appear in the program. 

Creating a New Data File  
When pcaColumn is first loaded, the program is ready to obtain input for a new 
file. The data will not have a filename associated with it, therefore, Untitled 
appears in the Title bar.  

• Select File | New. This clears the screen and returns to the default settings of 
the program. If existing data have been changed prior to selecting the New 
command, pcaColumn asks if you want to save the data. At any time after 
starting a new file, use the File | Save As command to give the file a name. 

Opening an Existing Data File 
You can open pcaColumn data files that were previously saved to disk. pcaColumn 
reads files that have been saved in binary format (with COL extension).  

• Select File | Open. A dialog box appears. 

• All files with the COL extension contained in the current drive and directory 
are displayed in the File Name list box. 

• To open a file that exists in another drive or directory, select the drive or 
directory you want from the Drives drop-down list or the Directories list box 
respectively.  

• From the File Name list box, select the file to be opened, or simply type its 
name in the text box.  

• Choose the OK button. 

 



 

 

Saving the Data 

To save the data with the same filename:  
At anytime while editing a data file that has previously been saved under 
a filename, choose File | Save to save the changes under the same file name. 
Selecting the File | Save command before giving the data file a name displays the 
Save As dialog box.  

To give the data a new or different filename:  
• Select File | Save As. A dialog box appears. 

• All files with COL extension contained in the current drive and directory are 
displayed in the File Name list box. 

• To save the file to a drive or directory other than the default, select a different 
drive from the Drives drop-down list or a different directory from the 
Directories list box. 

• In the File Name text box, type a new filename. If no file extension is 
specified, .COL will be appended to the specified filename. 

• Choose the OK button. 

4-2  Operating the Program 



 

 

Importing Data 
Geometry, reinforcement or load data may be imported from a text file. The import 
file must be saved in pure ASCII (text) format. 

• Select File | Import. A dialog box appears. 

• Select the type of data you want to import: 
Service Loads, Factored Loads, Reinforcement or 
Geometry. 

• Choose the OK button. The Open Import file box 
is displayed. 

• All files with the TXT extension contained in the 
current drive and directory are displayed in the File Name list box. 

• To open a file that exists in another drive or directory, select the drive or 
directory you want from the Drives drop-down list or the Directories list box 
respectively. 

• From the File Name list box, select the file to be opened, or simply type its 
name in the text box.  

• Choose the OK button. 
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Printing the Results 
Once a successful run has been performed you may print the displayed diagram 
using File | Print Screen command. if the Solve | Results File option was selected 
you may print the results file using File | Print Results . pcaColumn sends the 
printout to the printer selected in the Print dialog box.  

• Select File | Print Results or File | Print Screen. A dialog box appears. 

 
• Select the printer to send the results to. 

• Use Print dialog controls to set up the printer options. 

• Choose the OK button to start the printing or choose the Cancel to terminate 
the print job. 

General Information 
The General Information command allows you to define or change options that 
will affect the rest of the input.  
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• Select Input | General Information. 
A dialog box appears. 

• Enter the project, column, and engineer 
labels.  

• Select the units of measure, English or 
Metric.  

• Select the axis about which the column 
capacity is to be computed: X-axis, Y-axis, 
or Biaxial.  

• Select the design code to conform to: ACI 
318-02 or CSA A23.3-94.  

• Choose a run option: Investigation or 
Design.  

• Specify whether slenderness effects are to 
be considered or not.  

• Choose the OK button. 

Material Properties 
• Select Input | Material Properties. A dialog box appears. 

• Enter the concrete 
compressive strength, f’c. 
The modulus of elasticity, 
Ec; the constant stress 
intensity, fc, at the 
maximum usable strain 
used to calculate the force 
on concrete; the factor used 
to determine the depth of 
the stress block, Beta(1); 
and the maximum usable 
strain at the extreme 
concrete compression fiber, 
are automatically computed and displayed. Modify any of the values if 
different that computed.  
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• For the reinforcing steel, enter the yield strength, fy, and the modulus of 
elasticity, Es. 

• Choose the OK button. 

Section / Rectangular 

Inputting for the Investigation Option:  
• Select Input | Section | Rectangular. A dialog 

box appears. 

• Enter the width and depth of the rectangular 
section. Note that width is measured along the x-
axis and depth is measured along the y-axis. 

• Choose the OK button. 

Inputting for the Design Option:  
• Select Input | Section | Rectangular. A dialog box appears. 

• Enter the starting and ending values for 
each dimension (width and depth) along 
with an increment for each dimension. 
Note that the starting and ending values 
may be the same (in which case the 
increment must be zero).  

Choose•  the OK button. 

Section / Circular 

Inputting for the Investigation Option:  
ircular. A dialog box 

• diameter of the column section.  

Inputting for the Design Option:  
• Select Input | Section | Circular. A dialog box appears. 

• Select Input | Section | C
appears. 

Enter the 

• Choose the OK button.  
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• Enter the starting and ending values the 

h case the increment 

• 

Reinforcement / All Sides Equal 

diameter along with an increment. Note 
that the starting and ending values may be 
the same (in whic
must be zero). 

Choose the OK button. 

Th  Input | Reinforcemente  | All Sides Equal command allows you to enter the 
total number of bars in the column section. The program attempts to divide the 

des of a rectangular layout then equally space them 
on each side. Corner bars are associated with the top and bottom sides, and if the 

Inputt

rs in the 

•

• 
it is to the transverse (ties) or 

ars.  

 
angular section.  

• 

Inputting 
ent | All Sides Equal. A dialog box appears. 

bars equally between the four si

total number of bars is not a multiple of four, the top and bottom sides get the extra 
bars. For a circular layout, the program attempts to equally space the bars. 

ing for the Investigation Option: 
• Select Input | Reinforcement | All 

Sides Equal. A dialog box appears.  

• Enter the total number of ba
section (must be at least 4 and must be 
a multiple of 2 for a rectangular 
layout). 

 Select the bar size. 

Enter the clear cover and specify 
whether 
to the longitudinal b

• Select a bar layout, Circular or Rectan
a circular section and Rectangular for a rect

Choose the OK button.  

gular. The default is Circular for

for the Design Option 
• Select Input | Reinforcem
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• Enter the minimum and 

• 

ngitudinal bars.  

 
rectangular section.  

Reinf e

maximum total number of bars in 
the section (must be at least 4 
and must be a multiple of 4 for a 
rectangular layout).  

Select the minimum and 
maximum bar sizes along with 
the clear cover.  

• Enter the clear cover and specify 
whether it is to the transverse 
(ties) or to the lo

• Select a bar layout, Circular or 
a circular section and Rectangular for a 

Rectangular. The default is Circular for

orc ment / Equal Spacing 
The Input | Reinforcement | Equal Spacing command allows you to enter the 

mn section. The program attempts to place the bars 
rectangular layout. Corner bars are associated 

Inputt
. A dialog box appears. 

e 

• r cover and specify 
ransverse (ties) or 
ars.  

Inputting fo
ent | Equal Spacing. A dialog box appears.  

total number of bars in the colu
equally spaced on all four sides of a 
with the top and bottom sides and if the total number of bars is not a multiple of 4, 
the top and bottom sides will get the extra bars.  

ing for the Investigation Option:  
• Select Input | Reinforcement | Equal Spacing

• Enter the total number of bars in th
section (must be at least 4 and a 
multiple of 2).  

• Select the bar size.  

Enter the clea
whether it is to the t
to the longitudinal b

• Choose the OK button.  

r the Design Option:  
• Select Input | Reinforcem
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• Enter the minimum and maximum 

• the minimum and 

• 
ansverse 

•   

Reinforce

total number of bars in the section 
(must be a multiple of 4). 

Select 
maximum bar sizes.  

Enter the clear cover and specify 
whether it is to the tr
(ties) or to the longitudinal bars.  

Choose the OK button.

ment / Sides Different 

Inputting on:  
• Select Input | Reinforcement | Sides Different. A dialog box appears.  

 be placed on each of the top, bottom, left and right 
sides of the rectangular section. Note that corner bars are associated with the 

• K button.  

Inputting 
•  | Sid

roup, enter the minimum and maximum total number 
of bars to be placed on the top and bottom sides, along with the bar size and 

mber of bars must be greater than 4 and a multiple of 

for the Investigation Opti

• Enter the number of bars to

top and bottom sides.  

• Select the bar size and enter the 
clear cover for each of the top, 
bottom, left and right sides of 
the section.  

• Specify whether the clear cover 
entered is to the transverse (ties) 
or to the longitudinal bars.  

Choose the O

for the Design Option: 
Select Input | Reinforcement es Different. A dialog box appears.  

• In the Top and Bottom g

the clear cover. The nu
2. Corner bars are associated with the top and bottom sides. 
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• Select the minimum and 
maximum bar size and enter the 
clear cover.  

Repeat the steps above for the • 

• 
he transverse (ties) 

•   

 

Reinf e n 

Left and Right sides.  

Specify whether the clear cover 
entered is to t
or to the longitudinal bars.  

Choose the OK button.

orc ment / Irregular Patter
T
an

he Input | Reinforcement | Irregular Pattern command allows you to specify 
y number of bars (up to 500) to be placed anywhere within the column section. 

ional area. This command is available with the 

therwise, a dialog 

• 

• 
ist box.  

 button. To change 
ct 

Each bar may have any cross-sect
Investigation option only. 

• Select Input | Reinforcement | Irregular Pattern. If the section is irregular, 
The pcaSection window, where the 
section reinforcement may be graphically 
input, is displayed. O
box appears. 

Enter the bar area, along with its x- and y-
coordinates.  

Choose the Insert button. The data are 
added to the l

• Repeat the steps above for each entry.  

• To edit an entry, select it from the list 
box, modify its values in the text boxes, 
and choose the Modify
the area for several bars at once, sele
those bars from the list box, enter the new 
area in the Area text box, and choose 
Modify.  
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• 

• 

Reinf e  

To delete a bar entry, select it from the list box and choose the Delete button.  

Choose the OK button.  

orc ment | Design Criteria
• Select Input | Reinforcem

command is available with
ent | Design Criteria. A dialog box appears. This 

 the Design option only. 

• 
inimum number of bars 

• 
 

• 

Reinf e

• Specify whether the column is to be 
considered Structural (default), 
Architectural, or Other. Notice that the 
minimum and maximum reinforcement 
ratios change depending on the 
selection. 

Choose whether bar selection is to be 
based on m
(default) or on minimum area of steel. 

To modify the limiting reinforcement 
ratios, choose Other. Enter the
minimum and maximum reinforcement 
ratios in the corresponding text boxes.  

Enter the minimum clear bar spacing 
and the design-to-required ratio.  

• Choose the OK button. 

orc ment / Confinement 
• Select Input | Reinforcem

• Select the type of bar confinem

ent | Confinement. A dialog box appears.  

ent: Tied (default), Spiral, or Other. The 

For th

eduction factor flexure and axial tension, 

capacity reduction factors change depending on the selection.  

• To modify the capacity reduction factors, choose Other for confinement type.  

e ACI code:  

Phi(a) is the reduction factor for pure axial compression,  

Phi(b) is the r
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Phi(c) is the reduction factor for 
combined flexure and axial

For 

duction factor for pure 
on, 

te. 

• Sp
pa  bar sizes. The 

• 

Slend n

 
compression. 

the CSA code: 

Phi(a) is the re
axial compressi

Phi(s) is the material resistance 
factor for steel, 

Phi(c) is the material resistance 
factor for concre

ecify the tie size associated with the 
rticular longitudinal

code requirements are used as defaults. 

Choose the OK button. 

er ess / Factors 
• Select Input | 

box appears. No
Slenderness | Factors. A dialog 
te: this command is available for 

• 
(used to compute the 

• 

Slend n

slender columns only.  

The default values, per the design code, for the 
stiffness reduction factor 
moment magnification factors) and the cracked 
section coefficients for beams and columns are 
displayed. To modify these values, select the 
User-defined option and enter your values.  

Choose the OK button.  

er ess / Design Column 
• Select Input | Slendern

axis or y-axis data groups
ess | Design Column. A dialog box appears. The x-

 may be disabled depending on the active run axis. 

• 

Note: this command is available for slender columns only. 

Enter the clear column height in the corresponding text box. 
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• Specify whether the column is braced against sidesway or not by selecting or 

• m of the critical load of all 

•  Length Factors group, specify whether the k factor(s) are to be 

• 

•  

clearing the Braced Against Sidesway option. 

For an unbraced column, enter the ratio of the su
story columns to the critical load of the column under consideration, 
(Sum Pc)/Pc. Also, enter the ratio of the sum of the factored axial load of all 
story columns to the factored axial load of the column under consideration, 
(Sum Pu)/Pu. 

In the Effective
user-input or computed by the program, by selecting the corresponding option. 

If you chose Input k Factors, enter the effective length factors for braced and 
sway conditions, Kb and Ks, respectively. 

Repeat the steps above for each active axis.

• Choose the OK button. 

 

Slenderness / Columns Above and Below 
• Select Input | Slenderness | Columns Above/Below. A dialog box appears. 

Note: this command is available for slender columns only for which the 
Compute k Factors option is selected in the Design Column dialog box.  
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• In the Column Above group, specify whether or not a column above the 

design column exists, by selecting or clearing the No column specified option.  

• If a column above exists; enter the center-to-center height, the width (along 
the x-axis), the depth (along the y-axis), the concrete compressive strength, 
and the concrete modulus of elasticity of the column above in the 

• 

• 

corresponding text boxes. For circular sections, enter zero for the Depth and 
input the section diameter in the Width box. If zero is entered for both Width 
and Depth, the dimensions of the design column will be automatically used. 

Repeat the same for the column below or, if the column above and the column 
below are the same, choose the Copy to Column Below button. 

Choose the OK button.  
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Slenderness / X-Beams 
• Select Input | Slenderness | X-Beams. A dialog box appears. Beams defined 

using this command span perpendicular to the x-axis. Note: this command is 
available for slender columns only 
for which the Compute k Factors 
option is selected in the Design 
Column dialog box and the run axis 
is biaxial or uniaxial x-axis. 

• From the Beam Location group, 
choose the appropriate option. The 
data group below updates 
depending on the selection.  

• For the selected beam, specify 
whether or not a beam exists, by 
selecting or clearing the No Beam 
Specified option.  

• If a beam exists; enter the center-to-
center span length, width, depth, concrete compressive strength, concrete 
modulus of elasticity, and moment of inertia (if different than computed) of 
the beam.  

• Repeat the steps above for the beams above right, below left, and below right.  

• Choose the OK button.  

Slenderness / Y-Beams 
• Select Input | Slenderness | Y-Beams. A dialog box appears. Beams defined 

using this command span perpendicular to the y-axis. Note: this command is 
available for slender columns only for which the Compute k Factors option is 
selected in the Design Column dialog box and the run axis is biaxial or 
uniaxial y-axis.  

• From the Beam Location group, choose the appropriate option. The data 
group below updates depending on the selection.  

• For the selected beam, specify whether or not a beam exists, by selecting or 
clearing the No Beam Specified option.  
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• If a beam exists; enter the center-to-
center span length, width, depth, 
concrete compressive strength, 
concrete modulus of elasticity, and 
moment of inertia (if different than 
computed) of the beam.  

• Repeat the steps above for the 
beams above right, below left, and 
below right.  

• Choose the OK button. 

 
 

Loads / Factored  
Whether designing or investigating a short (non-slender) column, factored loads 
consisting of applied axial loads and moments about the active axis may be input.  

• Select Input | Loads | Factored. A dialog box appears.  

• Enter the factored axial load in the Load 
text box.  

• Depending on the active axis, enter the 
factored moment about the x-axis, the 
factored moment about the y-axis, or 
both.  

• Choose the Insert button. The data are 
added to the list box.  

• Repeat the steps above for each factored 
load entry.  

• To edit an entry, select it from the list 
box, modify its values in the text boxes, 
and choose the Modify button.  

• To delete an entry, choose it from the list 
box and choose the Delete button.  

• Choose the OK button. 
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Loads / Service 
When designing or investigating a short or slender column, service level loads 
consisting of dead, live, and lateral (wind and earthquake) axial loads and 
moments at both column ends about the active axis may be input. These loads are 
then factored and combined based on the load combinations.  

• Select Input | Loads | Service. A dialog box appears.  

 
• For each of the load cases: dead, live, wind and earthquake, enter the axial 

load and the applicable moment (about x or y) at the column top and bottom.  

• Choose the Insert button. The data are added to the list box.  

• Repeat the steps above for each entry.  

• To edit an entry, select it from the list box, modify its values in the text boxes, 
and choose the Modify button.  

• To delete an entry, choose it from the list box and choose the Delete button. 

• Choose the OK button.  
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Load / Control Points 
A non-slender column may be investigated without inputting any loads. The 
capacity of the section is computed along with other important information. This 
command is not available for slender columns or under the Design option.  

• Select Input | Loads | Control Points. 

In the output file, key points on the interaction diagram are listed. For each 
point, the axial load and bending moment capacities, along with the 
corresponding neutral axis depth, are listed. 
For a biaxial run, these points are listed for bending about positive and 
negative X and Y axes.  
For a uniaxial runs, the bar-splice regions are indicated on the interaction 
diagram.  

Loads / Axial Loads 
When investigating a short column (uniaxial runs only), grouped factored applied 
axial loads may be input. The corresponding moment capacity for each load is 
computed and output. This command is not available under the Design option, for 
biaxial runs, or if the column is slender.  

• Select Input | Loads | Axial Loads. A dialog box appears.  

• To input a range of axial loads, enter the 
initial, final and increment values in the 
corresponding text boxes. To input a 
discrete (single) axial load, enter its value 
in the Initial text box, and enter zero in 
the Final and Increment text boxes.  

• Choose the Insert button. The data are 
added to the list box.  

• Repeat the steps above for each axial load 
entry you may have.  

• To edit an entry, select it from the list 
box, modify its values in the text boxes, 
and choose the Modify button.  

• To delete an entry, choose it from the list 
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box and choose the Delete button.  

• Choose the OK button.  

Loads / Load Combinations 
pcaColumn allows you to specify up to fifteen load combinations. The service load 
input under the load cases (dead, live, wind, and earthquake) are combined based 
on these combinations. A minimum of one combination must be input. 

• Select Input | Loads | Load Combinations. A dialog box appears. For a new 
file, the default combinations per the selected code are shown in the list box.  

• To add a new combination, 
enter the load factors or 
multipliers for each load case, 
Dead, Live, Wind, and 
Earthquake.  

• Choose the Insert button. The 
data are added to the list box.  

• Repeat the steps above for each 
load combination. Up to eight 
combinations may be defined.  

• To edit an entry, select it from 
the list box, modify its values 
in the text boxes, and choose 
the Modify button.  

• To delete an entry, choose it from the list box and choose the Delete button.  

• Choose OK when done.  

Fliping / Rotating the Section 
This command is available for Irregular sections and for sections with Sides 
Different or Irregular reinforcement.  

• Select Input | Flip/Rotate Section. A dialog box appears.  
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• Select one of the options: Flip section about 
x-axis, Flip section about y-axis, or Rotate 
section. The last option is available for 
irregular sections only.  

• If Rotate section is selected, enter the angle 
of rotation (clockwise is positive).  

• Choose the OK button. 

Executing a Run 
• Select Solve | Results File. This is an option that may be turned ON or OFF 

by choosing it again. With this option ON, an output file will be created while 
the program is solving. The output file is a text file that contains an echo of 
the input along with slenderness calculation output, load combinations, and 
the critical points on the interaction diagram.  

• Select Solve | Design Trace (design option only). This is an option that may 
by turned ON or OFF be choosing it again. With this option ON, if designing 
a column section, the program will pause at each cross section and 
reinforcement layout it tries, and display the cross section with its bars in the 
Information bar.  

• Select Solve | Execute. If more data are needed to solve the problem, an error 
box appears and you will be 
prompted for the required data. If 
all the needed data are input, the 
solver portion of pcaColumn will 
start executing. The Solving box 
appears with a progress indicator. 
Click Cancel to terminate the 
solution process. 

After a successful run, the interaction diagram or the contour plot is displayed 
in the Graphics area of the window.  

Viewing the Results 
Once a successful run has been performed with the Execute | Results File option 
ON, you may view the results file.  
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• Select View | Results. pcaColumn executes the pcaView program, an applet 
that enables viewing of text-based files.  

• Use the scroll bars or the cursor keys to navigate through the file.  

• Select Exit to quit pcaView and return to pcaColumn.  

Changing the Startup Defaults 
You can change some default settings that pcaColumn uses when it is started or 
when the File | New command is executed.  

• Select Options | Startup Defaults. A dialog bo

Enter the full path of

x appears. 

•  the directory to which 

•  the system of units, design code, and 

•  to be used 

• e to be 

• e options in the PCAPROGS.INI file.  

Changing the Rebar Database 

pcaColumn defaults when opening a data 
file.  

Select
rebar database to be used as defaults 
whenever a new file is started.  

Enter the name of the program
by pcaColumn when viewing results. By 
default, pcaColumn uses pcaView.  

Enter the number of lines per pag
used in formatting the results file.  

Choose the Save button to save thes

• Select Options | Rebar Database. A dialog box appears. 

To select a different set:  
et drop-down list, select the set to be used. 

To create or modify a user-defined set 
• From the Bar Set drop-down list, select User-defined. The Add, Delete and 

Modify buttons are enabled.  

• From the Bar S

• Choose the OK button. 
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• To edit an entry, select it from the list box, 

• an entry, enter the bar size, 

 the list 

• 

e a saved set, choose the Read 

• 

Supe p

modify its values, and choose the Modify 
button.  

• To delete an entry, select it from the list 
box and choose the Delete button.  

To add 
diameter, area and unit weight in the 
corresponding text box, and choose the 
Add button. The data are added to
box.  

A user-defined set may be saved to disk for 
use in other files. To do so, choose the 
Save button after inputting the bars. To 
retriev
button. Rebar database is saved to the 
PCACOL.BAR file.  

Choose the OK button. 

 

rim osing Diagrams 
Afte uting a run and selecting the File | Save command, the program saves 
the diagram data in a separate file that has the same filename as the input file, with 

e later read by the program and two diagrams (of 
different files) may be superimposed for the purpose of comparison. Note that the 

exists in another 
 the Drives drop-

r exec

an IAD extension. This file may b

run option (uniaxial or biaxial) of the two files must be the same  

• Select View | Superimpose. The open dialog box appears.  

• All files with the IAD extension contained in the current drive and directory 
are displayed in the File Name list box. To open a file that 
drive or directory, select the drive or directory you want from
down list or the Directories list box respectively.  

• From the File Name list box, select the file to be opened, or simply type its 
name in the text box.  
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• Choose the OK button. If the data is successfully read, the diagram from the 
IAD file (shown dotted) is superimposed over the currently displayed 

• 

Viewi  t

diagram.  

To clear any superimposed diagrams, select the View | Redraw command.  

ng he Diagram 
For a uniaxial ru
diagram. For a biax

n, the program computes and displays the P-M interaction 
ial run, the program computes the three-dimensional failure 

Whe t, 
and e

Viewi

gle or the values of the moments that 
ngle or Moments option, 

• 
le from the list, use the 

• 
 which 

• 

surface (P, Mx, My). The failure surface can be viewed in one of two ways: 

a) P-M interaction diagram (vertical slice at an angle measured from Mx)  
b) Mx-My contour curve (horizontal slice at a constant axial load). 
never the mouse cursor moves over the Graph area, the axial load, momen

 ecc ntricity are displayed in the Status bar. 

ng the Interaction Diagram  
• Select View | Interaction. A dialog box appears.  

• Specify whether you want to enter an an
produce a view angle by selecting either the A
respectively. 

If the Angle option was selected, 
select an ang
scroll bar to pick an angle, or simply 
enter the value in the text box.  

If the Moments option was selected, 
enter the values of Mx and My
produce a view angle. The value of 
that view angle is computed and 
shown in the Angle text box.  

Choose the OK button.  
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Viewing the Contour 
• Select View | Contour. A dialog 

box appears. 

• Select an axial load from the list, use 
the scroll bar to pick a load, or 
simply enter the value in the text 
box. 

• Choose the OK button. 
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Chapter 5 
Examples 

Example 1 – Design of a Short Column 
Determine the size and reinforcement of a column section to carry the following 
factored loads: 

Pu = 1,700 kips, Mux = 1,900 ft-kips, Muy = 1,200 ft-kips. 
The column section is rectangular, limited in width to 32 in but the depth could be 
as large as 48 in. The reinforcing bars are equally distributed on all four sides and 
the reinforcement ratio should be limited to 3%. Use 6-ksi concrete and 60-ksi 
reinforcing steel.  

1. From the File menu, choose New. Any 
input data is cleared and the default values 
are restored.  

2. From the Input menu, choose General 
Information.  
• Input the project header.  

• Select English units and ACI 318-02 
code.  

• Select Biaxial for run axis, Design for 
run option and No for slenderness.  

• Choose Ok.  

3. From the Input menu, choose Material 
Properties.  
• Input 6 for the concrete strength. 

Other properties are computed and 
will be accepted.  

• Choose Ok. 

 



 

 
4. From the Input menu, choose Section | Rectangular.  

• For the section Width, input 
32, 32 and 0 under Start, End 
and Increment.  

• For the section Depth, input 
36, 48 and 2 under Start, End 
and Increment.  

• Choose Ok. 

5. From the Input menu, choose Reinforcement | Equal Spacing.  
• Input 20-#9 bars for 

minimum and 40-#11 
bars for maximum.  

• Input 1.5 in for the cover 
and select Transverse bars.  

• Choose Ok. 

 

 

6. From the Input menu, choose Reinforcement | Design Criteria.  
• Under Column Type, select Other.  

• Input 3 for Maximum Reinforcement Ratio.  
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• Choose Ok.  

  
7. From the Input menu, choose Loads | Factored.  

• Input 1700, 1900 and 1200 for the Load, X-Moment and Y-Moment, 
respectively.  

• Choose Insert to add the entry to the list box.  

• Choose Ok. 

8. From the Solve menu, choose Execute.  
• The solver of the program is started and, upon completion, displays the 

selected section that passes the design (32x38 with 22-#11 bars).  

• The Mx-My contour at zero-axial load is displayed in the Graphics area.  

9. From the View menu, choose Interaction.  
• The Angle list displays the Mx-My angle for the input moment(s). 

Choose 32 from the list.  

• Choose Ok. The PM interaction diagram (at 32-deg Mx-My angle) is 
displayed in the Graphics area. The load point is indicated on the 
diagram. 
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10. From the View menu, choose Contour.  

• The Design Axial Load list displays the value(s) of any input load(s). 
Choose 1700 from the list.  

• Choose Ok. The Mx-My contour at P = 1700 kips is displayed in the 
Graphics area. The load point is indicated on the diagram.  

11. From the View menu, choose Results.  
• Page through the results file.  

• Choose Exit to quit the pcaView program and get back to pcaColumn.  

12. From the File menu, choose Print Results.  
• Select the printer to send the text results to. 

• Choose Ok. 

13. From the File menu, choose Print Screen.  
• Select the printer to send the graphical results to. 

• Choose Ok. 

 

5-4  Examples 



 

 

Examples  5-5 



 

 

5-6  Examples 



 

10/13/04 pcaColumn V3.63 - PORTLAND CEMENT ASSOCIATION -                           Page   2 
 15:55:30 Licensed to: PCA, Skokie, IL                                              Example1 
 
   General Information: 
   ==================== 
      File Name: C:\Program Files\PCA\pcaColumn\Examples\Example1.col 
      Project:  PCACOL Manual, Biaxial 
      Column:   Ex_1                         Engineer: PCA 
      Code:     ACI 318-02                   Units: English 
 
      Run Option: Design                     Slenderness: Not considered 
      Run Axis:   Biaxial                    Column Type: User-defined 
 
   Material Properties: 
   ==================== 
      f'c   = 6 ksi                          fy   = 60 ksi 
      Ec    = 4415.21 ksi                    Es   = 29000 ksi 
      Ultimate strain = 0.003 in/in 
      Beta1 = 0.75 
 
   Section: 
   ======== 
      Rectangular: Width = 32 in             Depth = 40 in 
 
      Gross section area, Ag =  1280 in^2 
      Ix =  170667 in^4                      Iy =  109227 in^4 
      Xo =  0 in                             Yo =  0 in 
 
   Reinforcement: 
   ============== 
      Rebar Database: ASTM A615 
      Size Diam (in) Area (in^2)   Size Diam (in) Area (in^2)   Size Diam (in) Area (in^2) 
      ---- --------- -----------   ---- --------- -----------   ---- --------- ----------- 
      #  3      0.38        0.11   #  4      0.50        0.20   #  5      0.63        0.31 
      #  6      0.75        0.44   #  7      0.88        0.60   #  8      1.00        0.79 
      #  9      1.13        1.00   # 10      1.27        1.27   # 11      1.41        1.56 
      # 14      1.69        2.25   # 18      2.26        4.00  
 
      Confinement: Tied; #3 ties with #10 bars,  #4 with larger bars. 
      phi(a) = 0.8,  phi(b) = 0.9,  phi(c) = 0.65 
 
      Layout: Rectangular 
      Pattern: Equal Bar Spacing  (Cover to transverse reinforcement) 
      Total steel area, As = 34.32 in^2 at 2.68% 
      22 #11   Cover = 1.5 in 
 
   Factored Loads and Moments with Corresponding Capacities: (see user's manual for notation) 
   ========================================================= 
                  Pu          Mux         Muy       fMnx         fMny 
      No.         kip        k-ft        k-ft        k-ft        k-ft   fMn/Mu 
      --- ----------- ----------- ----------- ----------- ----------- -------- 
        1      1700.0      1900.0      1200.0      1927.6      1217.5    1.015  
 
      *** Program completed as requested! *** 
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Example 2 – Capacity of a Non-Sway Column  
Check the capacity of an interior column, located on the third floor of a braced 
frame. The frame has 5 bays (24 ft on centers) and 6 floors (14 ft floor-to-floor 
height).  

All interior columns are 18x18 and all exterior columns are 16x16. All interior 
columns of the third floor have 8-#10 bars with 1.5 in cover. All beams are 48x12 
and support a 6-in slab. The moment of inertia of the T-section is 13,823 in4. Use 
4-ksi concrete and 60-ksi steel for all beams and columns.  

The service load values for the column under consideration are as follows: 

 Dead Live

P (kip) 230 173 

Top Mx (kip-ft) 2 108 

Bottom Mx (kip-ft) 2 -100 

 

The column is to be checked for the following load combination: 

U1 = 1.4 D  
U2 = 1.2 D + 1.6 L 
U3 = 1.2 D + 1.0 L 

1. From the File menu, choose New. Any 
input data is cleared and the default 
values are restored.  

2. From the Input menu, choose General 
Information.  
• Input the project header.  

• Select English units and ACI 318-
02 code.  

• Select About X for run axis, 
Investigation for run option and 
Yes for slenderness.  

• Choose Ok.  
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3. From the Input menu, 
choose Material 
Properties.  
• Input 4 for the 

concrete strength. 
Other properties are 
computed and will be 
accepted.  

• Choose Ok.  

 

4. From the Input menu, choose 
Section | Rectangular.  
• Input 18 and 18 for the section 

width and depth.  

• Choose Ok. 

 

5. From the Input menu, choose 
Reinforcement | Equal Spacing.  
• Input 8-#10 bars and 1.5 in 

for the cover and select 
Transverse bars.  

• Choose Ok.  

 

6. From the Input menu, choose Slenderness | Design Column.  
• Input 13 for the column clear height.  

• Check the Braced against sidesway option and select Compute ‘k’ factors.  

• Choose Ok. 
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7. From the Input menu, 

choose Slenderness | 
Columns Above/Below.  
• Clear the No column 

specified option.  

Input 14•  for the 
n

r 

• opy to 

• 

8. enu, choose Slenderness | X-Beams.  

cified option.  

r).  

colum  height 
(center-to-center) 
and leave the othe
data as is.  

Choose C
Column Below.  

Choose Ok. 

From the Input m
• Choose Above Left.  

• Clear the No beam spe

• Input 24 for the span (center-to-cente
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• Input 48 and 12 for the 
width and depth, respectively.  

• Input 13823 for the moment 
of inertia.  

• Leave the other data as is.  

• Choose Above Right and click 
on Copy From Beam Left.  

• Choose Below Left and click 
on Copy From Beam Above.  

• Choose Below Right and click 
on Copy From Beam Above.  

• Choose Ok. 

9. From the Input menu, choose Loads | Service.  
• Input 230, 

2.0 and 2.0 
for the dead 
Load, X-
Moment and 
Y-Moment, 
respectively.  

• Input 173, 
108 and -100 
for the live 
Load, X-
Moment and 
Y-Moment, 
respectively.  

• Choose 
Insert to add 
the entry to 
the list box.  

• Choose Ok.  
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10. From the Input menu, 
choose Loads | Load 
Combinations.  
• If the list displays 

thirteen c
leave the first three as 
they are. Select 
combinations four 
through thirteen and 
click Delete. Only the 
first three combina-
tions need to be 
considered. 

Choose Ok. 

ombinations, 

• 

11. om enu, choose Execute.  
and, upon completion, displays the 

12. Fr w menu, choose Results.  

w program and get back to pcaColumn.  

13 Fr
 

14 Fr enu, choose Print Screen.  
lts to. 

Fr  the Solve m
• The solver of the program is started 

interaction diagram of the section with the load point plotted within the 
diagram.  

om the Vie
• Page through the results file.  

• Choose Exit to quit the pcaVie

. om the File menu, choose Print Results.  
• Select the printer to send the text results to.

• Choose Ok. 

. om the File m
• Select the printer to send the graphical resu

• Choose Ok. 
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10/13/04 pcaColumn V3.63 - PORTLAND CEMENT ASSOCIATION -                           Page   2 
 16:18:31 Licensed to: PCA, Skokie, IL                                              Example2 
 
   General Information: 
   ==================== 
      File Name: C:\Program Files\PCA\pcaColumn\Examples\Example2.col 
      Project:  PCACOL Manual, Braced Col 
      Column:   Ex_2                         Engineer: PCA 
      Code:     ACI 318-02                   Units: English 
 
      Run Option: Investigation              Slenderness: Considered 
      Run Axis:   X-axis                     Column Type: Structural 
 
   Material Properties: 
   ==================== 
      f'c   = 4 ksi                          fy   = 60 ksi 
      Ec    = 3605 ksi                       Es   = 29000 ksi 
      Ultimate strain = 0.003 in/in 
      Beta1 = 0.85 
 
   Section: 
   ======== 
      Rectangular: Width = 18 in             Depth = 18 in 
 
      Gross section area, Ag =  324 in^2 
      Ix =  8748 in^4                        Iy =  8748 in^4 
      Xo =  0 in                             Yo =  0 in 
 
   Reinforcement: 
   ============== 
      Rebar Database: ASTM A615 
      Size Diam (in) Area (in^2)   Size Diam (in) Area (in^2)   Size Diam (in) Area (in^2) 
      ---- --------- -----------   ---- --------- -----------   ---- --------- ----------- 
      #  3      0.38        0.11   #  4      0.50        0.20   #  5      0.63        0.31 
      #  6      0.75        0.44   #  7      0.88        0.60   #  8      1.00        0.79 
      #  9      1.13        1.00   # 10      1.27        1.27   # 11      1.41        1.56 
      # 14      1.69        2.25   # 18      2.26        4.00  
 
      Confinement: Tied; #3 ties with #10 bars,  #4 with larger bars. 
      phi(a) = 0.8,  phi(b) = 0.9,  phi(c) = 0.65 
 
      Layout: Rectangular 
      Pattern: Equal Bar Spacing  (Cover to transverse reinforcement) 
      Total steel area, As = 10.16 in^2 at 3.14% 
      8 #10   Cover = 1.5 in 
 
   Slenderness: 
   ============ 
      Sway Criteria: 
      -------------- 
      X-axis: Braced column. 
 
                    Height      Width      Depth           I       f'c           Ec 
      Column Axis       ft         in         in         in^4      ksi          ksi 
      ------ ---- -------- ---------- ---------- ------------ -------- ------------ 
      Design  X         13         18         18         8748        4         3605 
      Above   X         14          0          0         8748        4         3605 
      Below   X         14          0          0         8748        4         3605 
 
      X-Beams       Length      Width      Depth            I      f'c           Ec 
      Location          ft         in         in         in^4      ksi          ksi 
      ----------- -------- ---------- ---------- ------------ -------- ------------ 
      Above Left        24         48         12       13823        4         3605 
      Above Right       24         48         12       13823        4         3605 
      Below Left        24         48         12       13823        4         3605 
      Below Right       24         48         12       13823        4         3605 
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 10/13/04 pcaColumn V3.63 - PORTLAND CEMENT ASSOCIATION -                           Page   3 
 16:18:31 Licensed to: PCA, Skokie, IL                                              Example2 
 
 
      Effective Length Factors: 
      ------------------------- 
      Axis     Psi(top)     Psi(bot)    k(Braced)      k(Sway)        klu/r 
      ---- ------------ ------------ ------------ ------------ ------------ 
       X         2.170        2.170        0.917        (N/A)        27.53 
 
   Moment Magnification Factors: 
   ============================= 
      Stiffness reduction factor, phi(K) = 0.75 
      Cracked-section coefficients: cI(beams) =  0.35; cI(columns) = 0.7 
 
      0.2*Ec*Ig + Es*Ise (X-axis) =  1.56e+007 kip-in^2 
 
      X-axis  ----------- Braced -------------   ------Sway ------ 
      Ld/Comb    Pc(kip)   Betad     Cm  Delta      Pc(kip)  Delta 
      ------- ----------  ------ ------ ------   ---------- ------ 
        1 U1        3766   1.000  0.000  1.000 * --- N/A --- 
          U2        5023   0.499  0.960  1.125   --- N/A --- 
          U3        4664   0.615  0.954  1.094   --- N/A --- 
      * Slenderness need not be considered. 
 
   Load Combinations: 
   ================= 
      U1  =  1.400*Dead + 0.000*Live + 0.000*Wind + 0.000*EarthQuake 
      U2  =  1.200*Dead + 1.600*Live + 0.000*Wind + 0.000*EarthQuake 
      U3  =  1.200*Dead + 1.000*Live + 0.000*Wind + 0.000*EarthQuake 
 
   Service Loads: 
   ============== 
          Load   Axial Load     Mx @ Top     Mx @ Bot     My @ Top     My @ Bot 
      No. Case          kip         k-ft         k-ft         k-ft         k-ft 
      --- ---- ------------ ------------ ------------ ------------ ------------ 
        1 Dead        230.0          2.0          2.0          0.0          0.0 
          Live        173.0        108.0       -100.0          0.0          0.0 
          Wind          0.0          0.0          0.0          0.0          0.0 
          E.Q.          0.0          0.0          0.0          0.0          0.0 
 
   Factored Loads and Moments with Corresponding Capacities: (see user's manual for notation) 
   ========================================================= 
      NOTE: Each loading combination includes the following cases: 
            First line  - at column top 
            Second line - at column bottom 
          Load             Pu          Mux         fMnx          
      No. Combo           kip         k-ft         k-ft   fMn/Mu 
      --- ------ ------------ ------------ ------------ -------- 
        1  1 U1         322.0          2.8        283.2  101.154  
        2               322.0         -2.8       -283.2  101.154  
        3  1 U2         552.8        197.1        231.8    1.176  
        4               552.8        177.3        231.8    1.308  
        5  1 U3         449.0        120.8        256.5    2.123  
        6               449.0        106.8        256.5    2.402  
 
      *** Program completed as requested! *** 
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Example 3 – Capacity of a Sway Column 
Check the capacity of an interior column, located on the third floor of a sway 
(unbraced) frame. The frame has 5 bays (24 ft on centers) and 6 floors (14 ft floor 
to-floor height).  

All interior columns are 18x18 and all exterior columns are 16x16. All interior 
columns of the third floor have 8-#10 bars with 1.5 in cover. All exterior columns 
of the third floor have 8-#8 bars. All beams are 48x12 and support a 6-in slab. The 
moment of inertia of the T-section is 13,823 in4. Use 4-ksi concrete and 60-ksi 
steel for all beams and columns.  

In addition to the gravity load analysis, a lateral load analysis due to wind was 
performed. The service load values for the column under consideration are as 
follows: 

 Dead Live Wind Earthquake

P (kip) 230 173 6 0 

Top Mx (kip-ft) 2 108 84 0 

Bottom Mx (kip-ft) 2 -100 -70 0 

 

The column is to be checked for the following load combinations: 

U1 = 1.4 D 
U2 = 1.2 D + 1.6 L 
U3 = 1.2 D + 1.0 L 
U4 = 1.2 D + 0.8 W 
U5 = 1.2 D +1.0 L + 1.6 W 
U6 = 0.9 D + 1.6 W 
U7 = 1.2 D - 0.8 W 
U8 = 1.2 D +1.0 L - 1.6 W 
U9 = 0.9 D - 1.6 W 

Based on preliminary computations, Pc for interior columns is 2,466 kips and Pc 
for exterior columns is 1,120 kips. With 2 exterior columns and 4 interior columns, 
ΣPc = 2x1,120 + 4 x 2,466 = 12,104 kips. For the column under consideration, the 
ratio ΣPc/ Pc = 12,104/2466 = 4.91. 
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Theoretically, the ratio ΣPc/ Pc would be different for each combination. Since the 
program allows for one ratio only, the most conservative one (the ratio due to the 
fifth load combination) will be used. For combination U5, the total factored 
gravity loads on the floor is ΣPu = 2,268 kips 
and the factored load on the column is Pu = 459 
kips. For the column under consideration, the 
ratio ΣPu/ Pc = 2,268/459 = 4.94.  

1. From the File menu, choose New. Any 
input data is cleared and the default values 
are restored.  

2. From the Input menu, choose General 
Information.  
• Input the project header.  

• Select English units and ACI 318-02 
code.  

• Select About X for run axis, 
Investigation for run option and Yes 
for slenderness. 

• Choose Ok. 

3. From the Input menu, pick Material Properties.  
• Input 4 for the concrete strength. Other properties are computed and will 

be accepted.  

• Choose Ok.  

 

Examples  5-17 



 

4. From the Input menu, pick Section | Rectangular.  
• Input 18 and 18 for the section width and 

depth.  

• Choose Ok. 

 
 
5. From the Input menu, choose 

Reinforcement | Equal Spacing. 
• Input 8-#10 bars and 1.5 in for the 

cover and select Transverse bars.  

Choose•  Ok. 

6. rom the Input menu, 

r the 

• 

• 

• k. 

7. rom the Input menu, ch

o-center) and leave the other data 
as is.  

 

 

F
choose Slenderness | 
Design Column. 
• Input 13 fo

column clear height.  

Clear the Braced 
against sidesway 
option and input 
4.91 and 4.94 for the 
Sum Pc/Pc and Sum 
Pu/Pu, respectively.  

Select Compute ‘k’ 
factors  

Choose O

 

F oose Slenderness | Columns Above/Below. 
• Clear the No column specified option.  

• Input 14 for the column height (center-t
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• Choose Copy to Column Below.  

Choose•  Ok. 

 
8. From the Input menu, choose Slenderness | X-Beams. 

• Choose Above Left.  

).  

spectively.  

• bove Right and click 

• ck on Copy From Beam Above.  

• Clear the No beam specified 
option.  

• Input 24 for the span (center-
to-center

• Input 48 and 12 for the width 
and depth, re

• Input 13823 for the moment of 
inertia.  

• Leave the other data as is.  

Choose A
on Copy From Beam Left.  

• Choose Below Left and click on C

Choose Below Right and cli

opy From Beam Above.  

• Choose Ok.  
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9. 
0 and 2.0 for the Dead Load, X-Moment and Y-Moment, 

• 

From the Input menu, choose Loads | Service. 
• Input 230, 2.

respectively.  

• Input 173, 108 and -100 for the Live Load, X-Moment and Y-Moment, 
respectively.  

• Input 6, 84 and -70 for the Wind Load, X-Moment and Y-Moment, 
respectively.  

• Choose Insert to add the entry to the list box.  

Choose Ok. 

 
10. From the Input menu, choose Loads | Load Combinations.  

• If the list displays thirteen combinations, leave the first nine as hey are. 
Select combinations ten through thirteen and click Delete. Only the first 

 t

nine combinations need to be considered. 

• Choose Ok.  
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11. From the Solve menu, choose Execute.  

 and, upon completion, displays the 

12. From

w program and get back to pcaColumn.  

13. 
to. 

14. nu, choose Print Screen.  
esults to. 

• The solver of the program is started
interaction diagram of the section with the load points plotted within the 
diagram. Note that point 2 falls just outside the interaction diagram 
indicating inadequate capacity of this section.  

 the View menu, choose Results.  
• Page through the results file.  

• Choose Exit to quit the pcaVie

From the File menu, choose Print Results.  
• Select the printer to send the text results 

• Choose Ok. 

From the File me
• Select the printer to send the graphical r

• Choose Ok. 
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 10/13/04 pcaColumn V3.63 - PORTLAND CEMENT ASSOCIATION -                           Page   2 
 16:26:38 Licensed to: PCA, Skokie, IL                                              Example3 
 
   General Information: 
   ==================== 
      File Name: C:\Program Files\PCA\pcaColumn\Examples\Example3.col 
      Project:  PCACOL Manual, Sway Col 
      Column:   Ex_3                         Engineer: PCA 
      Code:     ACI 318-02                   Units: English 
 
      Run Option: Investigation              Slenderness: Considered 
      Run Axis:   X-axis                     Column Type: Structural 
 
   Material Properties: 
   ==================== 
      f'c   = 4 ksi                          fy   = 60 ksi 
      Ec    = 3605 ksi                       Es   = 29000 ksi 
      Ultimate strain = 0.003 in/in 
      Beta1 = 0.85 
 
   Section: 
   ======== 
      Rectangular: Width = 18 in             Depth = 18 in 
 
      Gross section area, Ag =  324 in^2 
      Ix =  8748 in^4                        Iy =  8748 in^4 
      Xo =  0 in                             Yo =  0 in 
 
   Reinforcement: 
   ============== 
      Rebar Database: ASTM A615 
      Size Diam (in) Area (in^2)   Size Diam (in) Area (in^2)   Size Diam (in) Area (in^2) 
      ---- --------- -----------   ---- --------- -----------   ---- --------- ----------- 
      #  3      0.38        0.11   #  4      0.50        0.20   #  5      0.63        0.31 
      #  6      0.75        0.44   #  7      0.88        0.60   #  8      1.00        0.79 
      #  9      1.13        1.00   # 10      1.27        1.27   # 11      1.41        1.56 
      # 14      1.69        2.25   # 18      2.26        4.00  
 
      Confinement: Tied; #3 ties with #10 bars,  #4 with larger bars. 
      phi(a) = 0.8,  phi(b) = 0.9,  phi(c) = 0.65 
 
      Layout: Rectangular 
      Pattern: Equal Bar Spacing  (Cover to transverse reinforcement) 
      Total steel area, As = 10.16 in^2 at 3.14% 
      8 #10   Cover = 1.5 in 
 
   Slenderness: 
   ============ 
      Sway Criteria: 
      -------------- 
      X-axis: Unbraced column. Sum of Pc = 4.91*Pc   Sum of Pu = 4.94*Pu 
 
                    Height      Width      Depth           I       f'c           Ec 
      Column Axis       ft         in         in         in^4      ksi          ksi 
      ------ ---- -------- ---------- ---------- ------------ -------- ------------ 
      Design  X         13         18         18         8748        4         3605 
      Above   X         14          0          0         8748        4         3605 
      Below   X         14          0          0         8748        4         3605 
 
      X-Beams       Length      Width      Depth            I      f'c           Ec 
      Location          ft         in         in         in^4      ksi          ksi 
      ----------- -------- ---------- ---------- ------------ -------- ------------ 
      Above Left        24         48         12       13823        4         3605 
      Above Right       24         48         12       13823        4         3605 
      Below Left        24         48         12       13823        4         3605 
      Below Right       24         48         12       13823        4         3605 
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 10/13/04 pcaColumn V3.63 - PORTLAND CEMENT ASSOCIATION -                           Page   3 
 16:26:38 Licensed to: PCA, Skokie, IL                                              Example3 
 
 
      Effective Length Factors: 
      ------------------------- 
      Axis     Psi(top)     Psi(bot)    k(Braced)      k(Sway)        klu/r 
      ---- ------------ ------------ ------------ ------------ ------------ 
       X         2.170        2.170        0.917        1.602        48.11 
 
   Moment Magnification Factors: 
   ============================= 
      Stiffness reduction factor, phi(K) = 0.75 
      Cracked-section coefficients: cI(beams) =  0.35; cI(columns) = 0.7 
 
      0.2*Ec*Ig + Es*Ise (X-axis) =  1.56e+007 kip-in^2 
 
      X-axis  ----------- Braced -------------   ------Sway ------ 
      Ld/Comb    Pc(kip)   Betad     Cm  Delta      Pc(kip)  Delta 
      ------- ----------  ------ ------ ------   ---------- ------ 
        1 U1        3766   1.000  0.400  1.000         2466  1.212   
          U2        5023   0.499  0.960  1.125         2466  1.430   
          U3        4664   0.615  0.954  1.094         2466  1.323   
          U4        3798   0.983  0.908  1.007         2466  1.180   
          U5        4702   0.602  0.942  1.083         2466  1.332   
          U6        3851   0.956  0.924  1.000         2466  1.134   
          U7        3766   1.000  0.960  1.063         2466  1.173   
          U8        4626   0.628  0.840  1.000         2466  1.314   
          U9        3766   1.000  0.943  1.014         2466  1.120   
 
   Load Combinations: 
   ================= 
      U1  =  1.400*Dead + 0.000*Live + 0.000*Wind + 0.000*EarthQuake 
      U2  =  1.200*Dead + 1.600*Live + 0.000*Wind + 0.000*EarthQuake 
      U3  =  1.200*Dead + 1.000*Live + 0.000*Wind + 0.000*EarthQuake 
      U4  =  1.200*Dead + 0.000*Live + 0.800*Wind + 0.000*EarthQuake 
      U5  =  1.200*Dead + 1.000*Live + 1.600*Wind + 0.000*EarthQuake 
      U6  =  0.900*Dead + 0.000*Live + 1.600*Wind + 0.000*EarthQuake 
      U7  =  1.200*Dead + 0.000*Live - 0.800*Wind + 0.000*EarthQuake 
      U8  =  1.200*Dead + 1.000*Live - 1.600*Wind + 0.000*EarthQuake 
      U9  =  0.900*Dead + 0.000*Live - 1.600*Wind + 0.000*EarthQuake 
 
   Service Loads: 
   ============== 
          Load   Axial Load     Mx @ Top     Mx @ Bot     My @ Top     My @ Bot 
      No. Case          kip         k-ft         k-ft         k-ft         k-ft 
      --- ---- ------------ ------------ ------------ ------------ ------------ 
        1 Dead        230.0          2.0          2.0          0.0          0.0 
          Live        173.0        108.0       -100.0          0.0          0.0 
          Wind          6.0         84.0        -70.0          0.0          0.0 
          E.Q.          0.0          0.0          0.0          0.0          0.0 
 
   Factored Loads and Moments with Corresponding Capacities: (see user's manual for notation) 
   ========================================================= 
      NOTE: Each loading combination includes the following cases: 
            First line  - at column top 
            Second line - at column bottom 
          Load             Pu          Mux         fMnx          
      No. Combo           kip         k-ft         k-ft   fMn/Mu 
      --- ------ ------------ ------------ ------------ -------- 
        1  1 U1         322.0          2.8        283.2  101.154  
        2               322.0         -2.8       -283.2  101.154  
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        3  1 U2         552.8        175.2        231.8    1.323  
        4               552.8        157.6        231.8    1.471  
        5  1 U3         449.0        110.4        256.5    2.323  
        6               449.0         97.6        256.5    2.628  
        7  1 U4         280.8         81.7        302.4    3.700  
        8               280.8         63.7        302.4    4.747  
        9  1 U5         458.6        289.5        254.3    0.879# 
       10               458.6        246.8        254.3    1.030  
       11  1 U6         216.6        154.1        324.0    2.102  
       12               216.6        125.2        324.0    2.589  
       13  1 U7         271.2        -76.4       -307.9    4.029  
       14               271.2        -68.1       -307.9    4.522  
       15  1 U8         439.4        -66.2       -258.6    3.906  
       16               439.4        -49.6       -258.6    5.216  
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       17  1 U9         197.4       -148.8       -328.7    2.209  
       18               197.4       -127.3       -328.7    2.582  
 
      #- Column section cannot resist applied loads 
 
      *** Program completed as requested! *** 
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Chapter 6 
The pcaSection Module 

pcaSection is an add-on module to the pcaColumn program. It enables the user to 
investigate irregularly shaped reinforced concrete sections subject to a 
combination of loadings. pcaSection considers a polygonal section reinforced with 
bars located at any location. The section may contain one opening. In addition, 
pcaSection allows easy modification of a circular section by converting it into an 
approximate polygon.  

pcaSection is accessed from within pcaColumn. Once pcaColumn is started, you 
can activate pcaSection by selecting the Section | Irregular command from the 
Input menu. This starts pcaSection, minimizes and locks the pcaColumn window 
and maximizes the pcaSection window. The section geometry may then be defined 
by drawing it on the screen or by inputting the coordinates of the polygon nodes. 
Once the section definition is complete, return to pcaColumn by selecting 
Save and Exit from the Main menu.  

Once the irregular section is defined, its reinforcement is input using pcaSection as 
well. This is done by selecting the Reinforcement | Irregular command from the 
Input menu of pcaColumn. The section reinforcement may also be defined 
graphically.  

 

 



 

Main Menu  

Drawing Area  
Set the limits for the drawing area and control the grid and snap settings.  

Save and Exit  
Accept the input and/or modifications made in pcaSection and return to 
pcaColumn.  

Exit without Saving  
Discard the input and/or modifications made in pcaSection and return to 
pcaColumn.  

Edit Menu  

Section  
Toggles the input/editing session to the section.  

Opening  
Toggles the input/editing session to the section opening.  

Reinforcement  
Toggles the input/editing session to the section reinforcement.  

Add  
Switches to the Add mode to graphically insert section or opening nodes or 
reinforcing bars.  

Delete  
Switches to the Delete mode to graphically delete section or opening nodes or 
reinforcing bars.  

Move  
Switches to the Move mode to graphically move section or opening nodes or 
reinforcing bars.  
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Modify  
Allows manual editing of the section or opening node coordinates or the 
reinforcing bar area and coordinates.  

View Menu  

Zoom  
Magnifies or reduces the graphical image.  

Pan  
Translates or moves the graphical image.  

Redraw  
Redraws the displayed section and resets the Zoom and Pan actions.  

Grid  
Shows or hides the grid.  

Snap  
Toggles the Snap On and Off. With the Snap On, the cursor snaps (sticks) to exact 
locations.  

Labels  
Shows or hides the internal numbering of section (or opening) nodes and bars.  

Status bar  
Shows or hides the Status bar.  

Help Menu  

Index  
Lists all the available help topics about the program.  

About  
Displays copyright information and the version number of the program.  
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Defining the Drawing Area  
• Select Main | Drawing Area. A dialog box appears. This step is not needed 

the first time pcaSection is started using pcaColumn’s Section | Irregular 
command. The box is automatically displayed. 

Input the li• mits (minimum and maximum) of 

• or the grid system. 

• 

• r the snap. The snap 

•  clear the Snap On option to activate 

•   

 

Graphical Editing of the Section or Opening  

the area within which the section is to be 
drawn in both directions.  

Input the interval (step) f
The grid is used as a guideline when drawing.  

Select or clear the Show Grid option to show 
or hide the grid.  

Input the interval (step) fo
settings may be different than the grid settings 
and may be different in each direction (x 
and y).  

Select or
or disable the Snap.  

Choose the OK button.

In pcaSection, the section (or opening) must be a closed polygon. It is defined by 

d to the cursor location are always displayed in the 

To add section or opening nodes:  
• Switch the input session to Section (or Opening) by selecting Edit | Section 

(or Edit | Opening). 

inputting the nodes at each corner or vertex of the polygon. No two segments 
(sides) may overlap or cross and no two nodes may coincide. An opening must lie 
completely within the section. 

The coordinates that correspon
Status bar. To force the cursor to “stick” to exact locations, turn the Snap option 
on. The program will snap to locations whose coordinates are multiples of the snap 
steps. 
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• Switch the input mode to Add by selecting Edit | Add.  

e, you can insert subsequent nodes.  

d location within the 

• d node follows the 

To delete s
• 

elete by selecting Edit | Delete.  

, pressing the left-mouse button and while holding the 
 dotted rectangle 

ton end the 

To move s
• 

ove by selecting Edit | Move. 

the button is held down, moving the cursor moves the 
at the new desired 
ion while holding 

• If you are editing a section (or opening), you must first click on an existing 
node. Once this is don

• Adding a node is done by moving the cursor to a desire
Graphics area and clicking the left-mouse button.  

After inserting a node, a line extending from the last adde
cursor. Click at another location to insert subsequent nodes. A line connecting 
the two nodes is drawn.  

• To end the drawing, click the right-mouse button or press the ESC key. The 
first and last nodes are connected to close the section. Also note that while in 
the Add mode, moving the cursor outside the Graphics area ends the drawing. 

ection or opening nodes:  
Switch the input session to Section (or Opening) by selecting Edit | Section 
(or Edit | Opening).  

• Switch the input mode to D

• Marquee select the node (or nodes) to be deleted. This is done by moving the 
cursor to one location
button down, moving to another location. While moving, a
(called the marquee) is drawn. Releasing the left-mouse but
marquee. All nodes that are enclosed with the marquee are deleted and the 
section (or opening) is redrawn. To cancel a marquee action while holding 
down the left-mouse button, press the ESC key or click the right-mouse 
button. Also, leaving the Graphics area cancels the marquee operation.  

ection or opening nodes:  
Switch the input session to Section (or Opening) by selecting Edit | Section 
(or Edit | Opening). 

• Switch the input mode to M

• Place the cursor over the node to be moved then press and hold the left-mouse 
button. As long as 
selected node to the cursor location. Once the node is 
location, release the mouse button. To cancel a move act
down the left-mouse button, press the ESC key or click the right-mouse 
button. Also, leaving the Graphics area cancels the move operation. 
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Graphical Editing of the Reinforcement  
In p
imp nates that 
correspond to the cursor location are always displayed in the Status bar. To force 

urn the Snap option on. The program will 
ultiples of the snap steps. While in the 

To add

Edit menu. 
A dialog box appears. 

box, input 1.  

• 

To genera

• Select Reinforcement from the Edit menu. A dialog box appears.  

of bars to be generated (should be greater than 1).  

dit box.  

caSection, the reinforcing bars may be located anywhere. The only restriction 
osed in the program is that no two bars may overlap. The coordi

the cursor to “stick” to exact locations, t
snap to locations whose coordinates are m
Reinforcement session, you cannot switch to the Section or Opening sessions 
without returning to pcaColumn. Therefore, the Edit | Reinforcement command 
will have a check mark to its left. You use the command to specify the bar size or 
area and the number of bars to be added. 

 one single bar at a time: 
• Switch the input mode to Add by selecting Edit | Add.  

• Select Reinforcement from the 

• In the Number of bars 

• Choose the Size option and select the size of the 
bar or choose the Area option and input the bar 
area in the edit box.  

• Choose the OK button.  

• In the Graphics area, point to the desired location an

Repeat the step above to insert more bars.  

d click. A bar is inserted.  

te multiple bars:  
• Switch the input mode to Add by selecting Edit | Add. The command must 

have a check mark left of it.  

• Input the number 

• Choose the Size option and select the size of the bar or choose the Area option 
and input the bar area in the e

• Choose the OK button.  
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• In the Graphics area, click at a location (let us call it point A), move the cursor 
to another location and click (let us call it Point B). The specified number of 

dded, along the line connecting the points A and B. 
ns, point B becomes A and you only need to click at 

• 

n.  

To delete b
• 

• Marquee select the bar(s) to be deleted. This is done by moving the cursor to 
cation, pressing the left-mouse button and while holding the button 

 rectangle (called 
 the marquee. All 

 

To move a
• t mode to Move by selecting Edit | Move. 

 Place the cursor over the bar to be moved then press and hold the left-mouse 
. As long as the button is held down, moving the cursor moves the 

ocation, release the 
wn the left-mouse 

equally-spaced bars is a
For subsequent generatio
the second point (B) to generate more bars.  

To end the multiple bar generation or move to another location (without 
adding bars), click the right-mouse button or press the ESC key. Also note 
that while in the multiple bar generation of the Add mode, moving the cursor 
outside the Graphics area aborts the generatio

ars:  
Switch the input mode to Delete by selecting Edit | Delete.  

one lo
down, moving to another location. While moving, a dotted
the marquee) is drawn. Releasing the left-mouse button end
bars that are enclosed with the marquee are deleted. To cancel a marquee 
action while holding down the left-mouse button, press the ESC key or click 
the right-mouse button. Also, leaving the Graphics area cancels the marquee 
operation. 

 bar:  
Switch the inpu

•
button
selected bar with it. Once the bar is at the new desired l
mouse button. To cancel a move action while holding do
button, press the ESC key or click the right-mouse button. Also, leaving the 
Graphics area cancels the move operation.  
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Manual Editing of the Section or Opening  
• Switch the input session to Section (or Opening) by selecting Edit | Section 

(or Edit | Opening).  

• Select Edit | Modify. A dialog box appears. 
If you have already defined a section (or 
opening), the coordinates of its nodes are 
shown in the list. 

• To add a node, enter its x and y coordinates 
and choose the Insert button. The entry is 
inserted in the list box following the selected 
entry.  

• To edit an entry, select it from the list box, 
modify its values in the text boxes, and 
choose the Modify button.  

• To delete an entry, choose it from the list box 
and choose the Delete button.  

• Choose the OK button.  

Manual Editing of the Reinforcement  
• Select Edit | Modify. A dialog box appears.  

• To add a bar, enter its area, x-coordinate and 
y-coordinate and choose the Insert button. The 
entry is inserted in the list box following the 
selected entry.  

• To edit an entry, select it from the list box, 
modify its values in the text boxes, and choose 
the Modify button. You can change the area of 
a group of bars by selecting them from the list, 
enter the new area and choose Modify.  

To delete • an entry, choose it from the list box 

• 

and choose the Delete button.  

Choose the OK button.  
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Zooming and Panning the Image  
Zooming is the enlargement or 
translation or movement of the im

reduction of the graphical image. Panning is the 
age.  

Zoomi
Zoom.  

zoom-in): using the left-mouse button, click anywhere 
ea. Click again for further magnification.  

Panni
• Select View | Pan. 

r the Graphics area. Press the left-mouse button and, while 
tton, move the cursor in the direction you wish to pan. A 

• 

Keybo  
The following keyboard assignments are always active: 

ng:  
• Select View | 

• To enlarge the view (
within the Graphics ar

• To reduce the view (zoom-out): using the right-mouse button, click anywhere 
within the Graphics area. Click again for further reduction.  

• To reset the Zoom and return to the default, select View | Redraw.  

ng:  
 

• Place the cursor ove
still holding the bu
line showing the amount and direction of panning is drawn. 

Release the mouse button. The view is panned and the image is redrawn. 

• To reset the Pan and return to the default, select View | Redraw. 

ard shortcuts:  

Key combination Action

Ctrl + Page Up Zoom-in 

n  

t zoom/pan (Redraw) 

 

Ctrl + Page Dow Zoom-out

Ctrl + Cursor key Pan 

Enter Rese
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Example 4 -Capacity of an Irregular Section  
This example uses the pcaSection module.  

Obtain the interaction diagram of a T-shaped section which contains a rectangular 
opening. The capacity is to be computed about the x-axis. The section is reinforced 
with 19-#8 bars, spaced 6 in. apart. The distance between the center of each edge 
bar to the face of the section is 3 in. Use 6-ksi concrete and 60-ksi reinforcing 
steel.  

Note: when instructed to move to a location 
(15, 25), move the cursor until the cells in the 
Status bar show “x=15” and “y=25”. 

 

1. From the File menu, choose New. Any 
input data is cleared and the default values 
are restored.  

2. From the Input menu, choose General 
Information.  
• Select English units and ACI 318-02 

code.  

• Select About X for run axis, 
Investigation for run option and No for 
slenderness. 

• Choose Ok.  

3. From the Input menu, 
choose Material 
Properties.  
• Input 6 for the concrete 

strength. Other pro-
perties are computed 
and will be accepted. 

• Choose Ok. 
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4. From the Input menu, choose Section | 
Irregular. The pcaSection module is loaded, 
its window occupies the desktop, and the 
Drawing Area box appears.  
• Input -3 and -3 for the minimum X and Y, 

respectively.  

• Input 45 and 45 for the maximum X and 
Y, respectively.  

• Input 3 and 3 for X and Y grid step, 
respectively and check the Show Grid 
option.  

• Input 3 and 3 for X and Y snap step, 
respectively and check the Snap On option.  

Choose O• k. 

5. e t session is Section and the Th  default inpu
default input mode is Add (the Edit | Section and Edit | Add options are 
checked). 
• In the Graphics area, move the cursor to the location (6, 0) and click the 

left mouse button. A node is inserted. 

• Move to (24, 0) and click the left mouse button. 

• Move to (24, 24) and click the left mouse button. 

• Move to (30, 24) and click the left mouse button. 

• Move to (30, 36) and click the left mouse button. 

• Move to (0, 36) and click the left mouse button. 

• Move to (0, 24) and click the left mouse button. 

• Move to (6, 24) and click the left mouse button. 

• Click the right-mouse button to end drawing the section. 

6. To define the opening nodes, switch the input session to Opening by selecting 
Edit | Opening. The input mode should still be Add (the Edit | Opening and 
Edit | Add options are now checked).  
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• In the Graphics area, move the cursor to the location (12, 6) and click the 
left mouse button. A node is inserted.  

• Move to (18, 6) and click the left mouse button.  

• Move to (18, 24) and click the left mouse button.  

• Move to (12, 24) and click the left mouse button.  

• Click the right-mouse button to end drawing the opening.  

7. From the Main menu, choose Save and Exit. You are returned to pcaColumn 
and the section is shown in the Information bar.  

8. From the Input menu, choose Reinforcement | Irregular. The pcaSection 
module is loaded, its window occupies the desktop. 

9. The default input session is Reinforcement and the default input mode is Add 
(the Edit | Reinforcement and Edit | Add options are checked).  

10. Define some bars using multiple bar generation: 
• From the Edit menu, choose Reinforcement. Input 5 for the Number of 

bars and select #8 from the Size list. Choose Ok.  

• Move the cursor to the location (3, 33) and 
click the left mouse button.  

• Move to (27, 33) and click the left mouse 
button. Five equally-spaced bars are 
generated between the two locations.  

• Click the right-mouse button to end.  

• Move the cursor to the location (9, 27) and 
click the left mouse button.  

• Move to (9, 3) and click the left mouse button. Five equally-spaced bars 
are generated between the two locations.  

• Click the right-mouse button to end.  

• Move the cursor to the location (21, 27) and click the left mouse button.  

• Move to (21, 3) and click the left mouse button. Five equally-spaced bars 
are generated between the two locations.  

• Click the right-mouse button to end. 
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11. Define the remaining bars using single bar placement: 
• From the Edit menu, choose Reinforcement. 

Input 1 for the Number of bars and select #8 
from the Size list. Choose Ok.  

• Move the cursor to the location (3, 27) and 
click the left mouse button. A bar is inserted.  

• Move to (15, 27) and click the left mouse 
button. Another bar is inserted. 

• Move to (27, 27) and click the left mouse button. Another bar is inserted. 

• Move to (15, 3) and click the left mouse button. Another bar is inserted. 

 
12.  From the Main menu, choose Save and Exit. You are returned to pcaColumn 

and the section is shown in the Information bar.  
13. From the Input menu, choose Loads | Control Points.  
14. From the Solve menu, choose Execute.  
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• The solver of the program is started and, upon completion, displays the 
interaction diagram of the section.  

15. From the View menu, choose Results.  
• Page through the results file. 

• Choose Exit to quit the pcaView program and get back to pcaColumn. 

16. From the File menu, choose Print Results.  
• Select the printer to send the text results to. 

• Choose Ok. 

17. From the File menu, choose Print Screen.  
• Select the printer to send the graphical results to. 

• Choose Ok. 
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   General Information: 
   ==================== 
      File Name: C:\Program Files\PCA\pcaColumn\Examples\Example4.col 
      Project:  PCACOL Manual, Irregular 
      Column:   Ex_4                         Engineer: PCA 
      Code:     ACI 318-02                   Units: English 
 
      Run Option: Investigation              Slenderness: Not considered 
      Run Axis:   X-axis                     Column Type: Structural 
 
   Material Properties: 
   ==================== 
      f'c   = 6 ksi                          fy   = 60 ksi 
      Ec    = 4415.21 ksi                    Es   = 29000 ksi 
      Ultimate strain = 0.003 in/in 
      Beta1 = 0.75 
 
   Section: 
   ======== 
      Exterior Points 
        No.     X (in)     Y (in)    No.     X (in)     Y (in)    No.     X (in)     Y (in) 
      ----- ---------- ----------  ----- ---------- ----------  ----- ---------- ---------- 
          1        6.0        0.0      2       24.0        0.0      3       24.0       24.0 
          4       30.0       24.0      5       30.0       36.0      6        0.0       36.0 
          7        0.0       24.0      8        6.0       24.0  
      Interior Points 
        No.     X (in)     Y (in)    No.     X (in)     Y (in)    No.     X (in)     Y (in) 
      ----- ---------- ----------  ----- ---------- ----------  ----- ---------- ---------- 
          1       12.0        6.0      2       18.0        6.0      3       18.0       24.0 
          4       12.0       24.0 
 
      Gross section area, Ag =  684 in^2 
      Ix =  82404 in^4                       Iy =  38340 in^4 
      Xo =  15 in                            Yo =  21 in 
 
   Reinforcement: 
   ============== 
      Rebar Database: ASTM A615 
      Size Diam (in) Area (in^2)   Size Diam (in) Area (in^2)   Size Diam (in) Area (in^2) 
      ---- --------- -----------   ---- --------- -----------   ---- --------- ----------- 
      #  3      0.38        0.11   #  4      0.50        0.20   #  5      0.63        0.31 
      #  6      0.75        0.44   #  7      0.88        0.60   #  8      1.00        0.79 
      #  9      1.13        1.00   # 10      1.27        1.27   # 11      1.41        1.56 
      # 14      1.69        2.25   # 18      2.26        4.00  
 
      Confinement: Tied; #3 ties with #10 bars,  #4 with larger bars. 
      phi(a) = 0.8,  phi(b) = 0.9,  phi(c) = 0.65 
 
      Pattern: Irregular    
 
      Total steel area, As = 15.01 in^2 at 2.19% 
 
      Area in^2   X (in)   Y (in)  Area in^2   X (in)   Y (in)  Area in^2   X (in)   Y (in) 
      --------- -------- --------  --------- -------- --------  --------- -------- -------- 
           0.79      3.0     33.0       0.79      9.0     33.0       0.79     15.0     33.0 
           0.79     21.0     33.0       0.79     27.0     33.0       0.79      9.0     27.0 
           0.79      9.0     21.0       0.79      9.0     15.0       0.79      9.0      9.0 
           0.79      9.0      3.0       0.79     21.0     27.0       0.79     21.0     21.0 
           0.79     21.0     15.0       0.79     21.0      9.0       0.79     21.0      3.0 
           0.79      3.0     27.0       0.79     15.0     27.0       0.79     27.0     27.0 
           0.79     15.0      3.0 
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   Control Points: 
   =============== 
                            Axial Load P     X-Moment     Y-Moment  N.A. depth 
      Bending about                  kip         k-ft         k-ft          in 
      --------------------- ------------ ------------ ------------ ----------- 
       X @ Pure compression       2803.1           -0            0      106.33 
         @ Max compression        2242.5          539            0       43.06 
         @ fs = 0.0               1387.9         1065            0       33.00 
         @ fs = 0.5*fy             925.1         1180           -0       24.54 
         @ Balanced point          598.8         1217            0       19.53 
         @ Tension Control         281.9         1454           -0       12.38 
         @ Pure bending              0.0         1178            0        8.18 
         @ Pure tension           -810.5            0            0        0.00 
 
 
      *** Program completed as requested! *** 
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Appendix 
Conversion Factors - English to SI 

 
To convert from  To  Multiply by 

in. m (1000 mm)  0.025400 
ft m  0.304800 
lb N (0.001 kN)  4.448222 

kip (1000 lbs)  kN  4.448222 
plf (lb/ft)  N/m  14.593904 

psi (lb/in.2)  kPa  6.894757 
ksi (kips/in.2)  MPa  6.894757 

psf (lb/ft2)  N/m2 (Pa)  47.88026 
pcf (lb/ft3)  kg/m3  16.018460 

ft-kips  kN • m  1.355818 
 

Conversion Factors - SI to English. 
 

To convert from To  Multiply by  
m (1000 mm) in  39.37008  

m ft  3.28084  
N (0.001 kN) lb  0.224809  

kN kip (1000 lbs)  0.224809  
kN/m plf (lb/ft)  68.52601  
MPa psi (lb/in2)  145.0377  
MPa ksi (kips/in2)  0.145038  

kN/m2 (kPa) psf (lb/ft2)  20.88555  
kg/m3  pcf (lb/ft3)  0.062428  
kN • m  ft-kips  0.737562  

 



 

Contact Information 
 

Web Site:  http://www.pcaStructurePoint.com

E-mail:  info@pcaStructurePoint.com  
 support@pcaStructurePoint.com  

Ordering:  pcaStructurePoint  
 Attn: Customer Service  
 5420 Old Orchard Road  
 Skokie, IL 60077  
 USA  
Phone:  (847) 972-9042  
Fax:  (847) 972-9043  

Technical Support:  pcaStructurePoint  
 5420 Old Orchard Road  
 Skokie, IL 60077  
 USA  
Phone:  (847) 966-HELP / (847) 966-4357  
Fax:  (847) 581-0644  
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Bug Report Form  
To help us improve our products please fax, mail or e-mail questions to:  

pcaStructurePoint 
5420 Old Orchard Road 
Skokie, IL 60077 
Fax: (847) 581-0644  
E-mail: support@pcaStructurePoint.com
 

Program 
 Name  

 Company 
Name  

 

Program  
Version  

 Tester’s 
Name  

 

Program  
Release  

 Phone 
  

 

Operating  
System  

 Fax  
 

 

CPU /  
Memory  

 E-mail  
 

 

Network 
  

 Input File  
 

 

Bug No.  
 

 Output File  
 

 

Date  
 

 Screen Shot 
File  

 

Bug Priority  
Category  
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Problem Title Please enter a brief, one-line description of the problem.  

Summary Information Restate the problem title and/or include more descriptive 
summary information.  

Error Messages If the problem causes any error messages, please list the exact error 
messages that you are receiving.  

Steps to Reproduce If the problem is reproducible, please list the steps required to 
cause it. If the problem is not reproducible (only happened once, or occasionally for 
no apparent reason), please describe the circumstances in which it occurred and the 
symptoms observed.  

Results Describe your results and how they differed from what you expected.  

Workaround If there is a workaround for the problem, please describe it in detail.  

Documentation & Notes Document any additional information that might be useful 
in resolving the problem.  
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